Ustone.

g4 A HREH

Eai— kN5 >H5—2
BuiheEnBHE

4 X MRS
( 2015.05.27 )



3 R 1= U7 L 5
At = == U PPTRPPIRt 5
3. IS =2 T TTDA TR )l i 6
T IO =55 P 6
32, A S R N b i e 6
R T N 00 - TR PPT 8
AN Dy e R W A A0 )= b S P 9
11 ) PN 9
=<1 PSPPSR 9
4.3, USB 2T D B . . ettt et ettt 10
A, BB R A L ittt 10
= A B A B 1 P 10
O Y KW =10 = PP 11
N R B k=P 12
T I =T 2= PSPPI 12
R 1 T 2= < 13
O -0 2 1) R 13
O O =T = YT SP PR 13
S R A K = || I I WU PPN 14
T 1 el A G - 1= 1= P 15
O B A 0 1= <P 16
A5, A IEIA o 17
O N T A (04 =5 VA P 17
O R W Ok =1 = - - OSSR PPUPRPPRN 18
5. NS =2 T S DBEBE . .o 20
5.1, FIWITRY I RODT 1 J7 et e e e e 20
T ) PP 21
TN T (1= 7= PP 22
T =T = PP 24
I G == )1 s P PP UPPTRRPPIN 25
6.1, BRI PO VS-C3 DHUT ottt e e eaeaaaas 25
6.2. Bluetooth T2 —)L VS-BTOO1 DB T ...euiritiiiiiiiii e ie e e ene e eae e 27



6.3. 77300 AIEEENR— R VS-IX008 DEUAT c.vuivriiiiiiiicii e 29
7. CERBRFEIRIEDA A N ) i 31
7.1, LPCXPrEss0 0 = R i e 31
7.2, LPCWAre A L —H — R ittt e 33
7.3, LPCXPresso DDA /A B b vttt 35
7.4. LPCXPresso RCE & 777 T A /R 0ttt 38
7.5. BTV —=RADFITO—= REATIR= B, 41
8. B T Y = R Il R E R T ittt 44
IR s I B 1 R b 1 P N T 44
8.2. BT ILY =R IL R e 45
8.3. BT ILY = RIIEBIA it 50
9. I T =2 SDK DR it 52
S O - 52
S =4 52
SRC TRy 1 e s TP N PN 52
SR> N I R O = -~ 53
0. . B D RE I . ..ottt 58
0.6. A R T D T ... o 63
10, DT IS =T S i 64
1O T N P PRSP RSPP PP 64
10.2. NS =2 T T RICDUNT ittt 64
L. B i s 66
11, DA O R 66
11,2, O = = R i e 66
3 G TR = i PP 66
O S 1~ PPN 67
1 T A i Y PP 68
L TR i B PP 69
11.7. DA T S AT R i 70
11,8, T T S DB i e 72
3 T R = o 1 72
TR 15T 73
20 TR 1o T 74
11.8.4.  ADC VS-IX008B ..utiiuiiitiiitiiiate ittt at ettt e e at et a e e e rae e atereaateraeanneans 75



11.8.5. UART.

11.8.6. B oo

11.9. 51> - {ZE



1. (XU&IC

ZOEUE, BHERZESBEVLEIFWEEESDNESTEINET,

AHRPE R, ARFFBEM E1— NS5 -2] (LEF KXERR) OERAEZFERUIZEDT
9. ZHEAICIRDEIC, BINEDHEAFIL CRIAZES KUARHMBZIHAGCILE, TER(CHENS
ZE0,

2. TER

@)

o O

O O OO

o O

AEREZMOPSIRCE ERFECRNIEL <HBFENZSN.
AHETBNVEEZSZRAVWTL SV, BETIENNHDFET,

AEEEKITHESUIZD, BRPLETDDZVGFITHERLZD LIdWTLZEW, 23— M2
ECKDHENREET DENNHDET,

ARENSENRELULHEE. I<ICERZHIDSTES0,
AREEHROELSTHERALED. BROFOES EZTBTHERELITD LI2WWTLES0N,
BFR. B LEORFHERCIZDIENSHDFTIOT, BHICTHNRNTIIZZU),

B EDimT (EFEED) ([CAND EHETDENNGDEFT ., BIEROFZMDKISICLT
<IZE0N.

ER EOmFRLINEBIRE TSI — DL BETDIENNGDFT.
AKETRNENDSATSY - B TILY —X(CEBHRNEBZIMZ SNIHBE. BR— NS
DIFIEIEIDFT



3. \5>85-=2770935ID1 > A M=)

NS28—-27005% (UTF. AYTRITT) [FUSBH—TILT PC & LIARRICH LT,
T DB - &'+ > DR - OJDBISEITAZY I MITFTY, COBETIEIRY I MITTD
A A R—ILSEIC DN TR LE T,

3.1. BFIRIZ
RKYI NI T7EETIBICIIUTOEERIENNRETY,
® XI5 OS Windows XP SP3 LA / Vista/ 7 / 8 / 8.1 (BAEEhR)

o fRRE 1024x768 LUt - JILAS—K=AJEE

MARBGE(C(E. [.Net Framework 4 A E] M ETY, CHEHSNB PCICA A B—=)LENTULVRT
N, Microsoft ODIR—LAR—EKDAF DT> 0O—-RU, 12X M=ILLULTLIESELY,

[.NET Framework 4] S>> 0—RY- k (Microsoft)
http://www.microsoft.com/ja-jp/download/details.aspx?id=17851

3.2. >R
A) UTFDURLMSA A =525 D>0—-RUET.

http://www.vstone.co.jp/products/beauto_balancer_2/download.html

B) AO>O—RMNTETUES. zip J7AILEFRERL I AILSFTHD
[Balancer2Programmer_Inst_***.exel ZEITUF T (***(C(F. /\—3 > BSHADET),

| Balancer2Programmer_Inst_1_
00.exe
(524 —2 JO4357 Setup



http://www.microsoft.com/ja-jp/download/details.aspx?id=17851
http://www.vstone.co.jp/products/beauto_balancer_2/download.html

==

KITIDEUTOHENITRRSNE T, UTFDOFIRTA > A M—ILZITVET,

Balancer2Programmer {7 b7y -

Baﬂlznceﬂprogrammer Tub7oF I —FD

Zle

COFOS T I ERO I 2 — 2 Balancer 2Programmer 10
FEADAF—IAET .

BT BEICROT VT — o E T ATEETUTERL .

BT THIIANRA L b Py IR T TBT I F oL E
LTS

el

DR 20Uy D

Balancer2Programmer 7y h7y7 - EN

AR - WERDIEE
Balancer 2Programmer ({22 F— ) LSEHIEEL TSGR 1

Balancer2Programmer 242 2 b — L F BT LA FIEEL T, DRAIEIwILTIH R,
5]

COFASSLIZRIE 03 MBOTRATEEREZE L ELLE T,

<E3(B SR > Feotb

[RAN &B#OUWD

TR MyIF(C23—b
Hy NEER T D55
F. FTvIZEAND

BalancerZrrogrammmer Ty

BN VDER
T DIBIARTEFRL TS

ELaa\aLn\ceQngva mmer -1/ 2 — JVBH ST I DIBAS R FEEIRUL. TR IE U LT

IEIDERAT
S e o w2 ) 20RO

<E3B AN Frl

RN Z2OUY D

Balancer2Programmer £y -7y -
'@?I?ancerZProgrammer T T I — o
5

SRR 2 — 512 Balancer 2Programmer Hitzy M7y dahEL
C::(er‘ajﬁ‘ 2 LFRITT BT I LA — VSR A R

b Py FERT TRIDATET IEI AL TR

Eg

(€71 Z20Uvo

META>RABM=ILERT T, TR MYIT (R ENES 33— bAY MBARY T I

TR TEET,

AV —VERET

[A>XA =L 200w D

Balancer2Programmer ty 7y - - IEd

R RS
BTERH AT OEBBRHELAS .

LT (fe] RIEERFEH A =
B H7E L <Fdr
[Balancer 2Froerammer {%

Yoo RGOS 5L

TIPS Lﬂw\mmm-ﬁs HEJ %:\ g— 5 J % 0 U W 0
ok Oa OB PHE RUATE
~CATRLET

AV DT O, RU. B DRRERELET

<FB) RN > Frel

[RAN &BOUWD

Balancer2Programmer b7y - EN
FOTS LGN —FDIEE
FO5SLT AT BT DA EL TR,

FOSSLOT AR T SIOFS LI —FEEELT. DR IE S » U TR

Balancer 2Programmer SRO

<BEaE [THERGSTT Fetl

RN] 20Uy D

Balancer2Programmer 737y -

Z{ERMOA 2 —5 Balancer2Programmer H AR — L DEERH TFE LI

%‘z;g(\/\/ﬂ%ﬁ?%ﬂ TIATA AR -V SRR P EEE T ITRAIE Ay 2L
AAR =5
C¥Program Files (xB8)¥Balancer 2Pragrammer
FRGZLLN -
BalancerdProgrammer
BN AT~ K
F ROk Ta =k oy MEPERR TR0

<ER® (YA Fetl




3.3. FF & DES
INS2H =284k (BUF. &K) &PCZUSBI—TJILTHES L. PCICAKRZERHSED L. BEICH
F73 USB HID A'EEINICA > A h—)LEeNF T, UTOFIBTITHRZS0N.

A) USB&—JJ)L (miniB&—2J)L) ZAEL. PC ARz HRULET.

miniB imF A Ui F

usB o —JJL AARIE(C USB(miniB i)zt LE I .

B) #EHRIDEUTDI 1> RIONKRENFEITDT, LESLFEFT,

=
T ADEGE
FIAREA A= ILTVET .
b Py TSR IPANESRT LA A - ATBETBASAAN. TS
— PHBEEHROTT.
|

C) BM~EHDFOE BENICAAM=ILATT L. D02 ROMSBELCSNET,
D) RSA/)UNBA2Rh—ILENTVIHZHERITDCE [TINARET IS —] ZEEULFET,

] FIARE I~
T &« TATOISMO-IL SCHRVIES » FIARERIS— b v

Us—aEm

Ly

14—

Metro771)

=HIE

Metro [ZHIDER

e

‘ FIARERI A~

e nAS L

» IRTHTOHIL AT

|7’nd§uc1-*-m@»ﬁ§ Q| SrobaTy b

E) [X¥EE] DIEEDH(C. Balancer2] EFXRRESNTUVWMUSIERECA A M—=)LENTWVET,



4. \S5>HB—=-277095IDERSE
CTTE, EASEEFIECZT O TRRLET,

4.1. &)

A= AZ2—BULLEFTRO MY T ZAOANESARY T NI T 7 Z2EE UET,

4.2, #{FEmE

i {5342 F0H5% 1_00 -0
Eg3 457
Frphf 2T FIEAE BEOEE
E<) £l & 7 Ry~
[ Product 1D 820 ungigned sh.. R
[ version 1 uns?gned ch.. 5 rg‘i jJ
[] MODE 1 urzigned ch
[ M.CURRENT.. 0 shart _ 5
[] MCURRENT.. 0 shaort |— UX |\J IJX I\GDFI v O%AHKIEEOD rgi
] TOURRENTL 0 shart o e
CJTOURRENT.. 0 [ short AEBURYITDO—ENFR 8] "MIST{bEnExd
[ GURRENTD.. 0 shart
] GURRENTO.. 0 show
[] BODY_ANGLL. 0 double SNFE9
[ BODY_ANGLE 0 double -
[ BODY_ANGLL. 0 double R
[ WHEEL_ANG.. 0 double R
[ WHEEL_ANG.. 0 double R
[ WHEEL ANG_. 0 double R R
[ WHEEL_ANG.. 0 double R o2
I TsPDL 0 B double R
CITEPDR 1 double RA 5 e \Sms
 evoL ) B e e B OJZBUS9 dNKTEL. B
] ENG R 0 lohg long R P "
Ol GYRODATA 0 short R BLEOJZREEFCTCEET
[] ADGGLA 0 unzigned sh.. R
[JapcclLe i} unzigned sh.. R
[] ADG_C_RA i} unzigned sh.. R ¥
< » ¥ Center 0 v o WiDiv 100 H/Div 1000 ¥ msec
o ] i5@h
PG->RAM BODY WHEEL WHEEL OTHER, 04794 UE [ ] T — 1 ON/OFF
GORRELATION GURRENT P OPTION1 OPTIOMY %72
FATSED 1 1 1 100023 0 0 -
ANGLE ANGLE ANGLE CURRENTI  OPTION2  OPTIONS po e
R AR -36400 1320 2400 0012 0 ]
Sy ANGRUERSPD  ANGRUERSPD  ANGRUERSPD  GYROHPF  OPTIONS  OPTIONG 2 -
-E460 396 360 19995 0 0 D
T BT OoemiE & \d/sec) 5
= E =4 »
[ > REE] [EHE— R

B A > DEZFHEL. RAM

KERG> =B & N\S2H—-2

NERDXF D ENTEFT ZEMTDIENTEFT



4.3. USB r—J )L DS
EHAR. 3.318 [REAEDER] ZTSR<TIES0,

NS>8 —=2®d CPUR— RZ PCHERE CENE, BFEEOAE L(C il SRRSNFT. F.
EH CETTUVVRWEE(E. [RIER] ERRSNZET.

i / Ji53H—2 TOY5X verl.0

o —

Il g | 457
Dl o e 1 LA PR A HTERTE BOEE
E=Tn) #Hig & a7 Ry
[] Product ID 2320 unzigned sh.. R
g Yerzion 1 unzigned ch.. R
4.4. BlRzAN3

FEDASA RAAYFZRAEE(CASA FUTERZANT I . BRZAND & FRELED 88 LED
HEARITUET.

FIEDASA RAA v FZRESE 2DD LED BT UE T,
([CRASA RULET,

4.5. FvUJL—>3>

FrUTL—>a>E KERBFRICAGREBNE TITVWET (RY> - RS54 R v F(ELEEZE),
AEDIRIERS > % 1 BT EF v UTL—>a>haED. §5 BRERE LED A UET. FrU
JL—23a>hE79dE. /B LED (E4TU. B LED (iU ET .

. )

¥ NN (2 S L R FrUIJL—>3>5%T#. FRELED

7~ LED WML E 9. PUTU. B8 LED AL ET,

10



4.6. BISTEMFDRIA
KADRIEMFERIGSEET .
A) KR ZFE CTRIDREDOER(ICUTF CTZAFTY,

B) BERY> 2T & KNMEANBRIENFEMIG UET . BERZROTCIRFERIFERTZHMLTH S,
WO DEFZRMULTTFE0N,
XIRFZIEUSIHSIRWEEBFE T (CANTLENFTIDT, ANZHBEEFTRXASNDLD
(S, BFRREDOKDEFZRL TSN

BERY >
=Y

fF1Eh BERY > Z2iig &0 KD
RIS EMF IR LR

11



4.7. 05 J %R
DX MARDRRUIEWVWINSA—SIDF TV IRV IR ZIIY IO LFTYVIRMITDRE. TSTITHFHL
EEHFRRENEFT, FTVIURTOIEED [#E] NS TJICRMENET,

HHECRRESNTVWBURANE 1171 [SATSUAEUNYT] EEAUABTERODTEDEIDOT, TESETS
B0,

i NZ4-2 JOY5Y verl.0 - o

i3 3
FrobsHANMT iR

HiE 2

s

[V GYRODATA 437
[JaocGLlA 0
O ADGGLE 0
[JADGGRAE 2
[]ADGGRE 0

[ PADLETH 0

[ PADANFRR 0
[]PaDANRY D
[IPADANLK 0 | |
O pADLANLY 0

[] USERARIAT D

[] USERARIAZ D

[ USER_ARIAZ 0

[] USER_ARIA4 0

[] USERARIAS D

= ¥ Center 0 v ¥/Div 100 v H/Diy 1000 v|nsec

4.8. HEIRDZEE
[H/Div] ERFRSNIZABDOIZARY VRDBRRBZEE I D&, HEBMOENEESNE T, 1
(FEFREH R UET .

J54—2 T0953 verl.0 = © J535—2 JOASY verl.0 1aEE 1 VZ—
555 2000ms (C
RESND

g

¥ Center |0 v ¥ Div 100 v H/DBv

12



4.9. HtVEDZEE
[V/Div] EFRRSNIZAEBDIZARY JRXDERRNEZEET DL, HBHDIENEE SNEK T, Hitdh
(FURMADINS A= DERUET .

N2 JOU57 verl.0 = B JS524-2 0453 verl.0 = =

37

| \ \ Y | J]l J‘ . ! &
“"a./ “"v'/ / ""a,f/'“n‘ j” } ““\4\,1/ \“\,/ "‘L;-/f \‘"l‘f

Ih.

50 [CZE

¥ Center v ¥/Diw [0 ! v H/Div /1000 v|nsec ¥ Center -128 v ¥/Div v H/Div |00

4.10. PRIRDIEED
[V Center] EFRRSNIZABDIZARY IRDBERRNBZEET DL, ARBEIBEILET,

J5H-2 TOUSR verl. - o J524—2 T0U5% verlo0 -5

457

¥ Center ] v YiDiv [100 v H/Diy 1000

1580 st

4.11. FIEEES
KA ZELESEB (T BRIEMFR(CIRERY 2 ZHUE T IMFZIEDHD EBANTUERSZSH, 7.
AREFTRATHSFEIESE TS0,

/e T\

N

AFZF TR,
BERY > &Y

VA ISy BERY 2T & AMEDEMFEFIELET

13



4,12. 95 J%&EBNT S
4.7 [0S DR EEBIC. 5 IFBIMUEWST—SDF T VIR I 2 EEEERI w7 UF
TYOEMTBRE. TSITTHENEINESNET,

1 JI5349-2 70957 1_00 -

b3
FrodhsIADRIT #THRIE BOEE

ESED) BiE & 57 i~
7] Product ID 8320 unzigned sh.. R

[] wersion 1 unzigned ch.
[1 MoDE ik} unziened ch..
[] MGURRENT.. -15 chart

[] M.GURRENT... 79
[J TCURRENTL -

R
R
R
R

BHEFRF T
D7fITD

&

o~
BODY_AMGLL.. 48677

ENG_R -202 long lore
GYRO_DATA 151 chart

DS T (CHEHD
MITREND

A

[l aDCC LA 1] unzigned sh..
[ apccLE a1 unzigred sh.
" e oL

Moarme s na

R
] WHEEL_ANG.. -233 R
[] WHEEL_ANG.. -6223.. double R
[] WHEEL_ANG .. 2505 double R
[ WHEEL_ANG.. -2518. double R
[]TSPDL 0 B douhis R
[ | TSPDR 0 double R
ENG L -201 [ tone lone R
R
R
R
R
"o

XFIT VI URICEENS T IS I TENRRSINRWNES(E, 4.918 [HlBOZEE ] >, 4.1018 [
SURDIEE) | Z2BE(C. JSITRMNIZRBLU T LSV (BUENKETE D, HdWINSTEBZ
EICKD. TSTORAITHEMURES RN ENHDET),

) Centerl 250 V_j ‘."/Divl 100 V_j H/ADiy | 1000 ¥ oeoe

RO b

ftiaDZEE

14



4.13. #HtE— R TEMI S
A) FT. K& PC%ZE USB T —JILTHERBRUIRET, 4.6 18 [BISZIEMEDRIE] ERERIC, FIZ8)

VEEBASEET,
1BERS > l\

fE1E BERY &g & KD
BIXIEMFZRIIE LR

B) #{FE— K ON/OFF DEMCHDF TV IRYIRZI IV I UL TFIYVIZEMTET,

igﬁ EEEEEEEEEREDN
OO%EZpA0ME | u[ ] HBREE—F ON/OFF u
f%ﬁ A4 | E R EERBERERNERRE] v

OSAR3EIHA

(mzec)

] Y

-

O4%ERS JEE (rad/ zec) 5

C) BERERY>Z2HF &, [#E(rad/sec)] DEBECHDTFINRY TXADERET, AMEDKEID
HESEHFT

04 %291 )z
A ™~

O+ AR 3 EIER
[mzec) §
2 Y
= \
e £ ——— — — — -
OU%ERRF |i$f§(radfsec:} ] |
REZKTEL. REWRF>ZHUET KEIRA > DEE (CENDE TEHFET

GRE [5] DIBA 5[rad/sec]DRE THEHET)

XIRME— RTEINIBRIE. AERDEA| - IR (CTTERSIZEV. Fz, USB U —TJILDE<EHEANT
LT IEEN,

15



4.14. 1> DEE
TA 2RI DL UTORTHRENZ 12 BDTFI MRY IR ZREL. [51> ] ORIE

ELZET.

[ 51 \
BODY WHEEL WHEEL OTHER o4
I CORRELATION CURRENT P QPTIONM1 OPTIOM4 I
1 1 1 0.00017
I ANGLE ANGLE ANGLE CURRENTI  OPTION? OPTIONE I S 1
-36400 1320 2400 0.012
Py I ANGRUER SPD ANGRUER SPD BNGRUER SPD GYRO HFF OFTION3 OPTIONE
-5460 306 360 0.9995 0 , ot

ZCTClE BODY 1> 2ESATHFT,
HUTFoD [1] £o>TWBERIC, [1.5] EABULET.

PC->RAM

e B
—
r PC->RAM rBOEY i
RAM-FG | 1 1 e !
AFGLE ANGLE ARNGLE AMNGLE
LR -36400 1320 FAERE -56400 1320

T NS ANGRUER SPD ANGRUER SPD o JTGEETA AMGRUER SPD ANGRUER SPD
-546D 295 -546D 496
e BN 7 ILATRTT

[PC->RAM] RZ>ZH T &, /IS H—2 D RAMAG 1 > DEENEEENET,

= = 7 = riy

I poopam | | BoDY WHEEL WHEEL o
I I GORRELATON G

= REMN-TC T 1 1 1
ANGLE ANGLE ANGLE G

RO —36400 1320 2400
Sed A | ANGRUERSPD  ANGRUERSPD  ANGRUERSPD

-5460 306 360

74 NAIRTE

CORETES—EIMFER L CHELL S,
41318 [EME— R TR D] EARICKERY > ZHU T, KEZENLTHET,

FFELBENEDD, KEDBE - ARE(CHTDT 1 — R\ IORKRED, IV EFZET D
KIEREDFET, COLICTA2DRMEEEEITDET, ARIBMFEREI D ENTEET.
TAICEITDFME. 11918 [T1> - R Z2TEELIZE),

16



Frz, 12 DEZEUKABDETIC [PC->RAM] MY ZRUIBE. TS —XAvE—IHFRRSN
F9. TOR. BEDL/SA-HDEFNRRSNDDT. TDEZIELKAHDVELT, BE
[PC->RAM] R U TLIZE W, BIEDE/SA—FDFTFR MRY TR (FEB(CENDDFT,

Lo riat 1 WS

2

[ LOG_FLG_2 1 unsigned lon.. R
[]loGFlG3 1© unsigned lon.. R/
[ GAINBODY 1 B double RAR
[] GAINMWHEEL 1 double RA
] GAIN WHEEL.. 1 M doble RAN
= [ GAIN_BODY_.. -36400 double R
] GAIN BODY_.. -G460 double RA )
[ GAINWHEEL.. 1320 doubls R/ s e e R
[ ] GAIN WHEEL.. 396 doubls R/ @/ (GATN_BODY)
[ GAINWHEEL.. 2400 double EAL l

[] GAINWHEEL.. 360 f— —

[[] GAIN.CURRE.. 000023
] GAIN.GURRE.. 0012
[[] GAIN.GYRO_. 09995
[ GAIN.OPTIO.. 0

<

doublg

MiE> /(S A -4
DFTFR MRy IR
NEBCEDD

RAM->PG aaa 000017 1 1 _

ANGLE ANGLE ANGLE CURRENTI  OPTIONZ  OPTIONS LR
~36400 1320 2400 0012 ] ]

Sofibh | ANGRUERSPD  ANGRUERSPD  ANGRUERSPD  GYRO HPF  OPTIONZ  OPTIONS

5460 286 360 1.9995 ] ] QR

Eh&E> IcIEBD%
AT REND

R
PC->RAM BODY

RAM->ROM
2

JEE(rad/

A IAIFE

4.15. 1 > DEA
EEURT A VIERAM [OXESNEEITT, BRZUIDZEHEHITLFEVET,

[RAM->ROM] MY > Z#HF & JNS>2H—2 D RAM ([CXESNIZEREZ FlashROM ([CEBIAL T &MY
TEFI. ROMICESTRAV LT, ERZUSTE, 1> DENER DT EF2L, REREEIFRFC(
ROM [CEEFRAFNLET A TEMFSE ST ENTEET.

A

PC->RAM BODY WHEEL WHEEL o
CORRELATION ¢

BAMPS | ! ! 1
ANGLE ANGLE ANGLE G

RAAk=>FOM ~36400 1320 2400
o hfEEEA | ANGRUERSPD  AMGRUERSPD  ANGRUERSPD G

-5450 396 360

Pk PIRANES s

4.16. U1 > DA
[RAM->PC] N> 7T & ISP -2 D RAM [CEZTAFNZST (> %Z. BERND [F1>] D
BIENBESAFNLETFRAMNRY IINRRESED ZENTEFT,

~ Fa

U
PG> R bl BoDY WHEEL WHEEL o
CORRELATION o

e

RAM-PG || ‘ ! 1
— o  ANGLE ANGLE ANGLE G
F.dihd=2> R0t —3R400 1320 2400
oo | ANGRUERSPD  ANGRUERSPD  ANGRUERSPD G
~5460 396 360
B PIGNE e

17



4.17. OV %S IT S

BEREZITDET, KMROEMER(COTZED . BISLIZOJ DT —45% PC ([CRFIDIENTEE
T, AARD RAM ABE(CLD. A5 T 4Kbyte FTOOTZRETETET. OJZMBEENS <D
=D, FEEOYAZXNKELRDENT B EZOROTZMBLENMRIRDET,

A) FI. 4718 [DJ5TMR] ERAKIC. OJZBBULEVWEBOFTYIORY IR &I v I U,
FIvIZANET,

1

5
FryiAy BT 118

NSoA—-2 JOH53 verl.0 - o

O glor
GYRODATA
] ADGGLA
[ ADG G LE
[] ADG G RA
[] ADG C_RE
[ FADBTH
[ PAD_AM_RX
[ PAD_AM_RY
[ PADLAM LK
[ PADAM LY
[] USER_ARIAT
[ USER_ARIA2
[ USER_ARIAZ
[] USER_ARIA4
[ USER_ARIAG
€

B) XI(C. OJEAE— RAYIDEZXDEHIC. [OIZEUE] RI>ZHUET,

ImEokia: =y

0o%ERE JEE(rad/sec) 5 DY EAE— RO

i OAEFEHT T30, BRI SRR T TR,

f\ POYEMERFFELED=HLET-
GHUEH T T IBLFBLEDA=ITLET -
DOYEIEE. EEEUSTICUSBISEREL. DFETF 1 IUCRF RS ZR
LTz

ERBIEZ K <FHedr
[OK] 20w o

18



C) NS2H—-2zEfr=tE. FKREDLED i"mN SUTICHIDEND EOJ DESMNT T LE T,
TOFEE, N\SoY—2DEF=EUST(C. PC LERL. [OJZT7AILITRE] IRTZHL

ig_o
XARD RAM TR (CRTFENDTzsd. BREZD EO0TF7 —INEESNE T,

,o——
|| 0VEZAAC | [ iktEE-F ON/OFF

[ ———— LS T ~

raod%x=2J71)LIC pUE SRS — —

#F] R =T 5 - L “
OiERRE? B (rad/sec) g

D) ®REZITSFAFZOINEIRLET ., REFEFXET7AILEZERD. [RiF] RY>ZHT L OTH
RIEFEENFT WHEADT 7 1IL&E. [FRrLWI 71 )lb.csvl ([TIRDFT).

1 REHDIPAVEBRL TUZA
(—) * T . « FFaxxb » Balancer2Programmer v & Balancer2Programmer®DiEE 0
EE~  FLLTLS- @
Xt BRIEAD & BHHE L
& Drophox BER T RISEEUBER A,
W ST
i BEFRUER
& Hon0-F
& F-nd-7
T7AIBZRDD
— \ b
Pl | TAMD1.csv v
TS a7 s = ) v [R12] &4
 EBA&() T Fea

- Tm-eEsLEREE)

19



5. I\5>Y—2 D’O9 S5V DHEE
CCTIINS =2 TOTSIDZDMOMEEC DWNTERSRUET,

5.1. FTYVIRYIRADOIVIUTP
[FTV IRV OIRDIIT | R =T E, EF T VIRV OIIANEF TV IONETHIRS
N9, Fle. BRERRFICOS TORMNEXET .

[FTwIRYDIAD
OUTF] R =Y

i <42 JOH5Y verl00 -0
i
Frohfe 2T TIER(E BOERE
B . RE & 7 Rt ~
Product 10 8320 unzigned sh R
[] Wersion 1 unzigned ch.. R
MODE 1490 unzigned ch R
[ M.CURRENT.. @ short R
[J M.CURRENT.. 2 short R
[J T.CURRENTL @ short R
[J T.GURRENT... 0 B short R
[JGURRENT.O. 0 short R
[ ] CURRENT.O.. 1 B short R
[] BODY_ANGU.. 00004, double R
[] BODY_ANGLE  0.0008.. double R
[] BODY ANGU.. 346.62.. double R
[ WHEEL_ANG.. 0 double R
[] WHEEL_ANG.. @ double R
[ WHEEL_ANG . 0 double R
[ WHEEL_ANG.. @ double R
TEFDL ] B double R
TSPDR 0 double RA
[JEMGL ] B fone long R
[JENCR 0 lone long R
GYRO_DATA  -24 short R
[ apccLa 1] unzigned sh R
[]aDpcGLE n unzigned sh.. R
[ S T

F I v IR

JIS3H—2 FOUST veri0D -

R o B R R o
BEOEE

il B At Rt \
[ Product ID 2320 unzigned sh.. R l
[ wsion 1 unsigned ch. R N —
] MBDE 190 unsigned ch.. R I 0 - 7@:%7?:55_‘ I
[] M.CURRENT.. @ short R b —
[ MEURRENT.. 2 short R I BFCEX D
[J TURRENTL @ short R I
[ TGURRENT_. 0 B short R
DCIRRENT_O... 0 short R
[JCMRRENT.O.. 1 B short R I I
[[] BODY_ANGU.. -0.000.. double R
O EIDY_ANGLE -1.785.. double R I
[] BBDY_ANGLL. 34fi62 double R I
[ WHEEL_ANG.. @ double R
[ WMEEL ANG.. @ double R I
[ WMEEL ANG.. @ double R I
] WHEEL_ANG.. @ double R
O TEPD_L 0 B double RA I
[]TSPOR 0 double RAM I
[JEyz.L 0 B one lone R
] Eio,R 0 lang long R ‘
[JGYRODATA  -2¢ short R I
[ apcGLa 1] unzigned sh.. R
O F\iC_C_LEI n unzigned sh.. R
I = A~ oa | rmimnd e D
-_—
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5.2. #IHA{E
[WIEA(L ] IR > ZH T & AERD ROM DRBEN I N THIERRE(C EEE 2N, &'+ > COJEBUSER
DFTFARY DIEHEPRERICRADFTT (KR & PC QMR DIRE TDHEMELE ).

A) FI. [¥HAL] RYZZRUFET,

J WAL ] RS> %3S 0

& —
Frphteh A0 P r%ﬂﬁﬁf 4 =TIES:
——
=) HIE B A7 Ry ™
[ Lo _onw 2 unziened sh.. R
[] LOGGHT n unsigned sh.. R
[ LoG FLG_ 1 1] ungigned lon.. RN
[ oG FLG_2 n unzigned lan.. R/
[ oG FLG_ 2 n unzigned lan.. R/
[ GAIN_BODY 1 B double R
[ GAINWHEEL 2 double RA
[ GAINWHEEL.. 3 B double RA
[ GAINBODY_. § double R
[ GAINBODY .. 9 double R
[ GAINWHEEL.. & double RA
[ GAINWHEEL.. 10 double RA
[ GAINWHEEL.. 7 double RA
[ GAINWHEEL.. 11 double RA
[ GAIN.GURRE.. ¢ double RA
[] GAINGURRE... & B double RA
[ GAIN.GYRO_.. 12 double R
[ GAIN.OPTIOL. 1 B doukle R
[ GAIN.OPTIOL. 14 double RA
[ GAIN.OPTIO.. 15 double R
[ GAIN.OPTIO.. 16 double A
[ GAIN.OPTIO.. 17 double RA
[ GAIN.OFTIO.. 0 double RA
T
< > ¥ Center 0 v Y/Diw 100 v H/D i | 1000 ¥ msec
X i
PC->RAM BODY WHEEL WHEEL OTHER 04% 274 JUE [ #REE— I ONAOFF
CORRELATION GURRENT P OPTIOM1 OPTIONS *F
G 1 2 3 i 1 16 .
ANGLE ANGLE ANGLE CURRENTI  OPTIONI  OPTIONG MIRRERE
FELAELY 5 8 7 8 1" 17
o B ANGRUER SPD ANGRUER 5PD ANGRUER SFD  GYRO HPF OPTION3  OFTIONG 2 £
So TR ! L " L 1 18 DUETE | amagsses) 5

B) #FHEAMEZITOMMER T DAY IRy IANFRRESNDDT, EFEFRZXL<FHH. [OK] Z#f
LEY,

RAMASROMADE A

S5 - 20RERIMELET . S5LITTH 2 SIEBEIEE L < B
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i
:
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C) AK®DROM D7 —45 E&TF X MRY IXDHENEMEENE T,

i Ji534—-2 TOY5Y 1_00 -0
-3 b
Fryhgahaman e AR anEE
Eat) Fﬂfﬁ \E Bl R
[] LoG_pry 1 ungigned zh..
[ LoG_GHT 0 I unzigned sh
[ oG FLG_1 0 unzigned lon
[ LoG FLG_ 2 0 unzigned lon
[ LOG.FLG 3 0 I unzigned lon...
[l GaINBODY 1 B double
[] GAINWHEELm 1 double
[] GAINWHEELR 1 double
[[] GAIN_BODY_.. -36400 double
[[] GAIN_BODY g -5460 double
[ zam wHEE] 1320 I double
[] GAINWHEEL.. 396 double
[ GAINWHEELR 2400 double
O GP.IN_WHEE'I:I 360 double

[] GAIN_GURRE.. 0.00023 double

[] GAIN GURRE. 0012 double
[J GANGYRO 09995 double

EEEEREERI SRR R

[] GAIN.OPTIO.. 1 B double
[ GAIN.OPTIOg 0 double
Caamortol o I double I "
[ 3AINOPTIO. 0 double U D [#E] &%
[ GAINCOPTIOg 0 double _ .
Cleamormol o I double TFRARRYOTAD
]
< > ¢ Genter |0 BN FIER{ =N D
P
PC-3RAM BODY WHEEL WHEEL GTHER [] HHEE — 12 ONSOFF
-— e mm omw omw s GOSRFLANONmm G RER il Thob
RAN PG ( 1 1 i 000023 ] N J—
ANGLE ANGLE ANGLE GURRENTI ~ OPTIOMZ  OPTIONG o RESE
RAMZROM. | ] ~86400 1320 2400 1mz 0 0
Ry ANGRUER SPD  ANGRUERSPD  ANGRUERSPD  GYRO HPF  OPTIONS  OPTIONG 2 :
-546D 396 360 09995 ] ] T .
AT | ¥ o e e b V[P | mieseen 5

5.3. [EDZEE
UABENIRATEIUYOTDE MEOEE] & [BOEE]| QIEEMNEHINEAZ1—HIERRS
nxEd,

i

E&
FryhfishADIT HMEA L EOEE

E=]] HiE B 57 Rty A

= YODE 0 ungigned ch...
IIRTEIIYITS oo —
rTIOGGONT 0 u AT —HFERSND
[ LOG_FLG_1 0 ungi
(J LOG_FLG_2 ] unsigned lon...

QG FLG_3 — g lor

]
[ GAIN_WHEEL EOVEE

Y R
[ GAIN_WHE . R
[ GaN_BoDy.. e R
[ GAIN_BODY . sl qub‘!} R
[] GAINWHEEL.. 1320 double R
[] GAIN_WHEEL.. 396 double R
[] GAINWHEEL.. 2400 double R
[] GAIN_WHEEL.. 360 double R
[] GAIN_GURRE.. 0.00017 double R
[ GAINGURRE.. 0012 [l double R
[] GAIN_GYRO_. 09995 double R
[ GAIN.OPTIO. 0 B double R
[ GAIN.OPTIO. 0 double R
[ GAIN.OPTIO. 0 double R
[] GAIN.OPTIO.. 0 double R
[ GAIN.OPTIO. 0 double R
[ GAIN.OPTIO. 0 double RAH v
L4 >
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5.4. BOXE
5.3 MEDQZE] LEKRICUR MEET IV OUL, [BOZEE] 2 ULFT. [BOEE] TIE J37(C
KRNI RDBZEECETEI, COMEEL [BOEE] RY> CEROMKEZIFSET,

B B O —— -
o wer e Te e FTEA{E BEDEE Frvited a7 FTHA{E I BOEE I
i wE ' A7 R A ] HiE & a7 = = s
[]LOGMODE 0 unsigned ch.. R L] USER_ARIAS 0 double R/

[ LOG DTy § unsigned sh.. R/ [ GALIBRATIS.. 0 B ursigned sh. RA
[ LOG GNT 0 unsigned sh.. R/ L] GALIBRATIS. § unzigned ch.. Al
[ LoGFLG I} unsigned lon.. R [] LoG_MODE 0 uns?gned ch.. R
CJLoGFLG?2 0 unsigned lon.. R/ [] LoG_Drv 5 unsigned sh.. R/
[ LoG FLe 8 0 unzigned lon.. R/ [] oG CNT 0 unsigned sh.. R/
[W|Ga BODY 1 Anihle [ LOG_FLG_1 0 unzigned lon.. R
[ GAIN WHEEL R [ LOG_FLG_2 I unzigned lon.. R/
[ GAIN_WHEEL R/ [JLOGFLGE 0 unsigned lon.. R/
Oa P.IN_BODY ) RN (WlGam BoDy (1 double .
[ GAINBODY.. 5460 dauble R L] GAIN WHE BOEE e R/
] GAIN WHEEL.. 1520 double R Lt GAINWHE ™ g g e ﬂ
[ GAIMWHEEL.. 206 double R/ L] GAIN BOD I

1 RATK WHEEL 9400 Ani ks oAb [ GAIN_BODY_.. -5460 double R

A) [BOZEE]| 20Uy 033E. [BORE] A 7OTNRRENET . CORE CBZREL.
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6. HLREROHMT

6.1. #&#®1> bO—3 VS-C3 DE
|IRI> hO—35 VS-C3 (BI58) =BG ITD &, EiTAM - Bz 7 FOJ AT« v I TEMTED X
SICIRDET,
XM OHEHES A TSV TIT O TVEIDT, HEHFD I 7 —LAD TV DIHE(CRDET,
B I aSZ(CHHTO0 S L El L T EE0,

1) AHEmEFHIC, UATOSRZRAELET.

wmIR 1> fO—= VS-C3 1ty k~
10 0% +T5wv =D)L (EE&EH)  150mm 118
RUD (M2-3KEEYvE>RL) 4 7K

2) I3y hr—DJILEAAEROD CN10 (. ORTYOOH L (BWEROE) Zm< KD ICEDMHT
P

oo
< &5 (cE

3) BEAHAEIRNELDIC, BRI —TIZRZIROIMUCETET .

RPN ERITD
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4) FAEERIOEDHIRIC, VS-C3 DREH (VS-RCV3) ZLUTOEE(ICRT D TEELET,

b ={takya)
[ < K5 (CHUS

6) T—JIINZENRHFEDILDCERIFT.

7) VS-C3 EARHERICEMBZAN. WINEXAANYFZANTT,

8) VS-C3 OEWNERAEZSE(C. XU TBIFZLET.

9) RFPUZINTET LS. EZHHFT.

10) BizdliilE =, EBMEIREBIC Uz e, A7FOT T« v O DRIETHIE - IR, £7730O0JX
T4 v ODEATELRD - AheblZiEitcE R,
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6.2. Bluetooth €5 1—JL VS-BT001 DEY

VS-BT001 (BI5E) ZED{IHTD &, IR TT —45 DEUSOARAORENHIEZ . Bluetooth Z#&# L1z
PC. Android AX—hJA 2 IRENDITDICENTEET,

FEHTOIS LDY>T)LY—X [Balancer2_firm_Uart] (C UART ZRUVSEEICE T 2UUEN S *
NTWnE9,

XAndroid AX—hIJA>AT7TY  VS-C2 (CFIELTBDFEE A

1) AHmEEFHIC, ATORRZRAELET.

Bluetooth =1 —JL VS-BT001 1tzwv b
1050059+ J5w MMr—J)L (E&EEH) 150mm  11@
RUD (M2-3/KgEYvE>RL) 4 K

2) ISy RT—=JI)LZEIRD CN9 [CEBDIFEY. IRTIDON L (BHEROES) Zm<ELSI(C
HODFFET,

il tlYA)
[ < K5 (CEUS

3) WAHAFRNKD(C, BRI —TILZRZITNOIMITEITET .
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RN =ZEETD
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4) AEGERIDEDAHIIRIC, VS-BT001 ZUATFDOMEE(CHRS D TRAELET .

5) 73w bho—7J)L7%& VS-BT001 (C. ORTIDNEROHAIZB K KD ICERDMHITET,

6)
/)

8)

[ < K5 (THUYS

T=JIZENHEDLDICEREFT,
DTz & ARBOERZ AN, VS-BT001 ORRIDERED LED MUT L TULD Z & =R
ULTREULN,

VS-BT001 OEWRERAEZSZE(C. PC. Android AN— hIAREERFUZT UL, 9—ZFI)L
VI NI T7RETEBEZBRZLUTTS0,
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6.3. 7F0O2 A HILRAR— R VS-IX008 DHT

VS-IX008 (3I5%) ZEUTIF 2D E7FOTHADEH=ILRL. SIEITOJSACTERTZZENT
ETEY,

FHTO0 S L=lEk Y DimE. > 7)Y —X [Balancer2_firm_ADC_IX008] #Z&&E <20\,

1) AHmEEFHIC, ATORRZRAELET.

700 ADHERR— R VS-IX008 1ty b
U D (M2-3{KEES Y E> L) 4K

XVS-IX008 IBDT Sy hMr—JILE>OARTIP/EBESNTVEEA. EENHUWGS. BIR
EEBEHDT =TI EHENRDHZEN,

2) J5v b—J)LZEMRD CNO [CEDMIFET ., ORTYDOOHE (BHREROE) ZMKDIC
HODFFET,

Nl teikya)
[ < K3 (CEUS

3) 35w b —2)L%& VS-IX008 ([C. JRTIDOHERD LAZEBIK LD CEDMITET.

HRAt
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4) AAKRGRIOEDAHFIRIC, VS-IX008 ZATDOME(CRE D TEFELFT .

L

5) U= ZENREDIXRDCERFT.
6) VS-IX008 D=+ >/)\E> % IP1 D 3.3v lICELiAF. DIP XAV FZUTDLSCHELET,
XY TIWSATSURERTDIHEE. VS-IX008 D 12C 77 RL- X% 0x96 (CFRET DHENDD

[t

: OFF
: OFF
: ON
: ON

A W N

3.3vAlCHEET

-
N =
adr SH3

WMIIIN adg s
ox92 --
2x94 ON
9x96 ON

7) T OOEGICE LU TIE VS-IX008 DEWRERIAE Z28&E <120\,

30



7. CEERRRBDA A M=V
ARETE [Ea— NS> —-2] [CEHENS MCU [LPC1343] [CTEITSNIHIHTOTS LD
RS ECDWTERRUET .
EERMIN TS C EEHRSHREIRIE [LPCXpressol ZRW=H > AILTOTS A - SATSU%EE
AUZET,

[LPCXpresso] fHiihRODFIAFER TIN, 40> 0— ROBICI—F—HD> NEEk T 2REN
HDFET. Fle. EILRPAZXDHIBRNNMN D TVWETDT, 1> A M—JLEICRY NDO—D%=FBL
IEERHEREZE T DMEN DD FT,

7.1. LPCXpresso #Ao>0O—k
F9'. MERRRIED LPCXpresso #450>0O—RUET,
1) UFOYA MNMIF7OTERAULET,

http://www.lpcware.com/Ipcxpresso/home

2) Download the LPCXpresso IDE Z:&iRUFE T,

nT
VAN

Home Blogs Forums Projects Downloads FAQ My Account

Search this site ®) Search

User login

username
password m

Software & Support for NXP MCUs

LPCXpresso home

¥ Remember me
Home
I Create new account
S nmm d by Ipcxpresso-support on Wed, 2014-04-30 23:43 Request new password

PRESSO

{1s] it
LPCXpresso IDE IR ﬁa’esso

Download the LPCXpresso IDE
= LPCXpresso IDE Features

= Additional links
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http://www.lpcware.com/lpcxpresso/home

3)

4)

Windows Z&RUET.

Home Create new account
Submitted by Ipcxpresso-support on Tue, 2014-05-20 06:57 Request new password

ﬁ‘i, Y PRESSO
-@ZJ A

Table of Contents [show]

LPCXpresso IDE Downloads

Documentation

PRESSO

Before downloading, please read.

* LPCXpresso v7 User Guide

+ Also available - LPCXpresso v6 User Guide
+ LPCXpresso Release Notes
+ LPCXpresso End User License Agreement (EULA)

Product downloads
1EIR
Click on the operating system that you wish to run LPCXpresso IDE on to download the LPCXpresso IDE Sialler. 1&

+ Windows

+ Windows Vista or later is required. 32-bit and 64-bit systems are supported
“linux

+ Supported distributions are listed in the User Guide. 32-bit and 64-bit systems are supported
+ MacOSX

+ Mac OS X Mountain Lion (10.8.5) or later is required

Once downloaded and installed, you can activate LPCXpresso (Free Edition) or purchase LPCXpresso (Pro Edition) directly from the NXP LPCXpresso webstore.
Older versions of LPCXpresso IDE

Downloads of some older versions of LPCXpresso (v4 / v5) are available here. These are not recommended for general use.

Open Source components

LPCXpresso Open Source components information and downloads are available here

Current release @ Download LPCXpresso v7.*.* for Windows (current version) %Zi&iR9 D
EAVRA=SDA T O—-RMEEDET,

H

o Create new account

Submitted by Ipcxpresso-support on Sun, 2014-07-13 23:22 Request new password
—

?ux\ PRESSO

[/

File info 84
NXP verified:
YES PRESSO

Important Note

+ Following the discontinuation of support by Microsoft, Windows XP is no longer an officially supported platform. LPCXpresso may continue to work on Windows XP but this can no longer be
guaranteed. LPCXpresso is no longer tested on Windows XP.

LPCXpresso 7 Downloads
Note - All downloads are via HTTPS from an extemal site. ‘ls—:g ?R
Current release

+ 2, Download LPCXpresso v7.5.0 for Windows (current version)

Old releases

[, Download LPCXpresso v7.4.0 for Windows

Download LPCXpresso v7.3.0 for Windows

Download LPCXpresso v7.2.0 for Windows

Download LPCXpresso v7.1.1 for Windows

, Download LPCXpresso v7.0.2 for Windows
= NOTE - ensure that you follow this FAQ after installing - LPCXpresso v7.0.2 Indexer Issue

£, Download LPCXpresso v7.0.0 for Windows

LPCXpresso 6 Downloads
Users of LPCXpresso 6 are advised to update to LPCXpresso 7. An existing activation for LPCXpresso 6 will also allow the use of LPCXpresso 7.

+ 4, Download LPCXpresso v6.1.4 for Windows
* J Download LPCXpresso v6.1.2 for Windows
« J, Download LPCXpresso v6.1.0 for Windows
+ £, Download LPCXpresso v6.0.4 for Windows

Dk on snm Insnt | DOvnenann dsminade namn

XTA4T35Y - Y2 T)ILY—R(Ev7.3.0 THER L TLE T,
LW =23 > TEUSEELIRVMES v7.3.0 21 > A M—J)LUIE UK BIET DN THEERS IS0\,
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7.2. LPCware AND1—Y—&§5

EIL R+ XHIBREFRDOIEH [C(EI—TERNMBECIRDFE T, D> 0O— RZFo CLDMEIC, 1—
UERZEITVET.

1) BE. UTOYA MI7OERALEY,

http://www.lpcware.com/Ipcxpresso/home

2) Create new account ZiERUET,
N Globavengisn v

Home Blogs

Forums Projects Downloads FAQ My Account

LPCWARE "

L e

User login

Software & Support for NXP MCUs

o
LPCXpresso home

s ¥ Remember me

JES/N
Home

Create new account

Submitted by Ipcxpresso-support on Wed, 2014-04-30 23:43 Reale p
B

{15]
LPCXpresso IDE

= Download the LPCXpresso IDE

= LPCXpresso IDE Features

= Pro Edition

= New functionality in LPCXpresso 7
= New functionality in LPCXpresso 6
= Additional links
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http://www.lpcware.com/lpcxpresso/home

3) w/AEIAZE#E L. Create new account Z&ERUZE T,

User account

Home » User account

Create new account Login Request new password

IMPORTANT: PLEASE READ: You must provide a valid email address to use this site. If you don't get the verification email - usually within a few minutes, check your spam box. If you do
not get the verification email within 24 hours, please use the FEEDBACK tab to send us an email so we can authenticate your account. Once you register, a verification email will be sent
to you with a temporary password to sign onto the site and authenticate your account

|—Account information:

Username: *
Iusema me
Spaces are allowed; punctuation is not allowed except for periods, hyphens, and underscores.

E-mail address: *

A valid e-mail address. All e-mails from the system will be sent to this address. The e-mail addres 5 is not made public and will only be used if you wish to receive a new password or wish to receive certain news or
nofifications by e-mail

— » XML sitemap-
|—Persona| Information:

Full name: *

Optional: Enter your full name. This will not appear on any public pages. The content of this field /s kept private and will not be shown publicly.

c

[ |

Enter your company name. This will not appear on any public pages. Please do not enter a fake name such as "abc123' as this will cause your account to become blocked. Leave the field blank if you would prefer not
to enter your company name. The content of this field is kept private and will not be shown publicly.

c

Enter your company company website URL. This will not appear on any public pages. The content of this field is kept private and will not be shown publicly.

Select the newsletter(s) to which you wish to subscribe.

[C] www.Ipcware.com newsletter

—CAPTCHA:
This question is for testing whizther you are a human visitor and to prevent automated spam submissions.

What code is in the image?: *

Enter the characters shown in the mage.
|

' IR

Create new account

4) LPCware W'SFRsEX—ILANESNTEFET ., TIICRBSNTLBD URLZIYYIL, OJA

2 UEY,
bad

Home Blogs Forums Projects Downloads FAQ My Account

LPCWARE |

=

Software & Support for NXP MCUs ﬁmzsso

Reset password
tome M

This is a one-time login for vstonetest and will expire on Fri, 2014-11-07 18.00 NXP LPCZone tweets
Report an issue
Click on this button to login to the site and change your password

BER

This Inain £an be used only once

Login

INT. I—YEHIZTTTI,
XA—ILEENRWNEE, BERUHNSITOTIES,
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7.3. LPCXpresso D1 >ABM—=)L

A>O—RUEA > X =55 LPCXpresso 1 > A M—JLULZE T,

1) 9>0-RUEAAB=3ZFTULET,

LPCXpresso_7.5.0_254.exe
zl LPCXpresso Installer

v NXP Semiiconductors USA, Inc.

2) UTOFIECK ST, AR —ILZEDHFT,

Welcome to the LPCXpresso
Setup Wizard
This will install LPCXpresso 7.5.0 [Build 254] on your computer.

PRESSOQO | itisrecommended that you dlose all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

Welcome to LPCXpresso

LPCXpresso provides a complete Rapid Embedded Development environment for
INXP LPC Microcontrollers.

LPCXpresso consists of the following components
- LPCXPresso IDE, an Edlipse-based Integrated Development Environment (IDE)
- LPCXpresso utilities, plugins, examples and documentahon
- GNU-based C/C++ compilation tools and doc d
- Command line utilities.
LPCXpresso runs on Microsoft Windows platforms (XP SP3 and later), both 32-bit
and 64-bit, many Linux distributions including Ubuntu and Fedora, and Mac OS X
(Lion or later)

Forum based support can be fout, JZEFR
v7.5.0_254

sl | <ek| [ mewt> || concel

The folder:
C:¥nxp¥LPCXpresso_7.5.0_254

does not existauld you like the folder to be created?

IR

(o O
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License Agreement
Please read the following important information before continuing.

Pleasereadﬂ'sefolomtgu:mseAgreement Ywmustac:eptthel:rmsofﬂls
Tel 1t before continuing with the

NXP SEMICONDUCTORS USA, INC.

End-User License Agreement for LPCXpresso Software Development
Tools

(Rev. 2013-06-28)

THIS END USER LICENSE AG] 2 SE")IS ALEGAL
AGREEMENT BETWEEN YOU N INDIVIDUAL, OR

CTATAT T TEAAT TATTITVY AN lgiR ADE TTCA TN

I do not accept the agreemen

Y7.5.0_254

http: /fwww.n:

Select Destination Location
Where should LPCXpresso be installed?

‘ Setup willinstall LPCXpresso into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

¥nxp¥LPCXpresso_7.5.0 254

At least 743.8 MB of free disk spe
¥7.5.0_254




Debug driver selection
Please select which drivers to install.

Windows may issue warnings when installing these drivers.
If prompted, please allow the drivers to install.
Drivers are located in the "Drivers” directory of the installation

INXP Debug drivers

Select Start Menu Folder
Where should Setup place the program's shortcuts?

v
Setup will create the program's shortcuts in the following Start Menu folder.

¥7.5,0.254
http: W,

To continue, dlick Next. If you would like to select a different folder, dlick Browse.

Select Start Menu Folder
Where should Setup place the program's shortcuts?

[a—

To continue, dlick Next. If you would like to select a different folder, dlick Browse.

v7.5.0_254

Setup will create the program's shortcuts in the following Start Menu folder.

http: /fwww.n:

Select Additional Tasks
Which additional tasks should be performed?

X

WPCXFRESSO

Select the additional tasks you would like Setup to perform while installing LPCXpresso,
then diick Next.

Y7.5.0_254

Additional icons:

http: /fwww.nxp.com

(®) For all users

() For current user only

Ready to Install
Setup is now ready to begin installing LPCXpresso on your computer.

R

Click Install to continue with the installation, or dlick Back if you want to review or ¥7.5.0_254 %
change any settings. http: W.n:

Destination location:

<ok | [ e
C:¥nxp¥LPCXpresso_7.5.0_254 .

Start Menu folder:
LPCXpresso v7.5.0_254

Additional tasks:
Additional icons: Instaling: )
Create a desktop icon Please wait while Setup installs LPCXpresso on your computer.
For all users
Install drivers:

NXP Debug drivers

<

C:¥...¥pcopen_examples_windows_usb_drivers_v1.20¥x86¥WdfColnstaller01011.dll

y7.5.0754

http: /fwww.nxp.com/lpcxpresso

v7.5.0.254

http: W.n:
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Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

LPCXpresso 7
== Supported Hosts ==

onMacOS X 10.7.

== Known Issues ==
*On Windows 8 and 8.1, if both
use: ‘Rediink' driver are cor

v7.5.0_254

LPCXpresso

*Following the discontinuation of support by Microsoft, Windows XP
is no longer an officially supported platform.
continue to work on Windows XP but this can no longer be
guaranteed. LPCXpresso is no longer tested on Windows XP.

*Mac OS X 10.7 (Lion) is no longer an officially supported
platform. LPCXpresso may continue to work on Mac OS X 10.7, but
this can no longer be guaranteed. LPCXpresso is no longer tested

may

and a debug probe that
aseRCink2 or 3

http: /fwww.n;

PRESSO

Completing the LPCXpresso Setup
Wizard

Setup has finished installing LPCXpresso on your computer.
The application may be launched by selecting the installed
icons.

Click Finish to exit Setup.

Display LPCXpresso v7.5 Documentation
LPCXpresso User Guide (PDF)

3) Finish Z&iR9d 3 &. LPCXpresso A& LET

Eile Edit Navigate Search Project Run Window Help
B HAE®-4 -

BHE-O-Q-|@ %o m

LERFLACOERANI BSOS G 1] ¢

X

25 Project Explorer 52 | , Peripherals+ | ! Registers|

\‘V'='E

O Quickstart ... 53 | ()= Variables| % | B= outline| 67

=
| =]

£ | Start here

@ Import project(s)
1€ New project...

o Build all projects []
K| Build " []

o Clean* [

5 Del
® Edit "
2% Import project(s) from XML Description
(2 Quick Settings

B Export projects t

B Export pr < to archive (zip)

-"

¥4 Extras

[avic Access || |
@ Welcome 3 | =08
B & [file:///C:/nxp/LPCXpresso_7.5.0_254/Ipoxpr g htm ve B
~
LPCXpresso (Free Edition) is fully activated
‘Weicome to LPCXpresso (Free Edition). The software is now fully activaled, and can be used for production. LPCXpresso
(Free Edition) can be used to generate and download applications containing up to 256KB of code 1o an LPC target
Product Documentation
The LPCXpresso User Guide provides instructions for using LPCXpresso. This is also available from the Help menu:
» Help->LPCXpresso User Guide
Further product documentation is provided within the LPCXpresso IDE via the Help menu
» Help->Help Contents
Resources
The LP NXP MCU users, including LPCXpresso, and is an
- getting wCus So,
and join the LPCware community!
- riew th visit LPCware Forums.
Check the following pages on LPCware.com for new NXP MCU and
‘announcements.
* LPCXpresso examples.
# LPCOpen source and examples.
* LPCXpresso support.
« LPCXpresso downloads.
Links v
© Console 52 | (21 Problems| [ Memory| ® Profile+|é” Data Watch+ | ) Int Statistics+ | i Int Trace+ | % Host Strings+ | € Instruction Trace| #B-m-=0
No consoles to display at this time.

LT, LPCXpresso D1 > A —=)LIFETTY,
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7.4. LPCXpresso DEBETFIFTANR—>3>

JU—RIFEIL REBA XCHIBRNHDDEIT DT, SATSUERRANTETI 7 1ILEIEKRT DIHEE.
SN EB(CIADZE T,

REEZEITD & 256kbyte FTORITI 7ML ZEILRTEDLDICIRADFET,

[\

1) LPCXpresso DA —1—m5[Help] >[Activate]>[Create serial numver and register(Free
Edition---1Z:#RLE T,

File Edit Navigate Search Project Run Window | Help
H-me|® 8> @i~ 0O~ Q@ HelpContents USOBERA/OEO LM -5 <
[ project Explorer £2 I?ﬁ Pen'pherals+! i Registersl , ;zxrc;:‘resso therGulde
Dynamic Help le:///C:/nxp/LPCXpresso_7.5.0_254/Ipcxpresso/pages/registeredFreeEd
Key Assist... Ctrl+Shift+L

Tips and Tricks...

@ Install New Software...
% Installation Details LPCXpresso (Free Edition) is f
Q Display license type Welcome to LPCXpresso (Free Edition). The software is now
(Free Edition) can be used to generate and download applici
©4  Product Information e
== Product Documentation
4 Support
for usin¢
s Activate » | I Purchase from LPCXpresso Webstore
©{  About LPCXpresso -- Free Edition — LPoxp
|4 Create serial number and register (Free Edition)...
I Activate (Free Edition)...
- Pro Edition — —
4 Activate (Pro Edition)... built fo
e On use
O Quickstart ... 2 |(X)= Variables| ®¢ Breakpoints| g= Outline| &< Expr&ionsl = 8 € Deactivate (Pro Edition)...
2 password reminder (Pro Edition)... bu can
71 Start here A Check the following pages on LPCware.com for new N
= announcements.
® Import project(s)
# LPCXpresso examples.

2) Yes Z&ERULFET,

This will overwrite your existing registration.
Continue?
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3) [Open in external browser](CF T wvo%ZAtl. OK Z&ERLET,

Create serial number and register (Free Edition)... ! v i

Select OK to visit the registration website where you can
register your product and receive an Activation Cede. LPCXPRESSO

Serial number | FT ’

[v]©Open in external browseri =~ IR

[ ] Copy Serial Number to clipboard

LPCXpresso Key Activation

Home » LPCXpresso home
Submitted by Ipcxpresso-support on Fri, 2013-06-07 09:22

ﬁRESSO / EED’L'\

RTgIsTEiTTEiO

Serial Number:* [FTME
A -
LPCXnresso Activation Key: |=valid once serial number is submitted= ‘

| Fiééi;ter IjF'CS(pr;sso 1 \
2R

5) FRSNJE Activation Key #1E— U,

Submission #39389

Home » LPCXpresso Key Activation » Submissions

View Edit

Thank you for registering your LPCXpresso product. YOUR ACTIVATION CODE IS DISPLAYED BELOW - please copy and paste it into your LPCXpresso IDE on your computer. You
should also receive an email with your activation code in a few minutes.

You product registration history can be located here or by selecting the 'My LPCXpresso activations' menu item in the sidebar.
You must be logged in with the account you used to register your product to view activation key history.

Registration Information

Serial Number:
FTN

LPCXpresso ActivationKey: /_ %?R L/‘C:I t°_

o1
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6) LPCXpresso MXA_—1—h5[Help] >[Activate]>[Activate (Free Edition) ]Z&RULEY,

]
File Edit Navigate Search Project Run Window | Help
H-le|®-8- @i~ 0~ Q@ HelpCotents U ELERA BB S P-EI L -5 5o
[ Project Explorer £2 | = Peripherals-«-| i Registers| ; Searc: Usenlide
Dynamic Help le:///C:/nxp/LPCXpresso_7.5.0_254/Ipcxpresso/pages/registeredFreeEdition.
Key Assist... Ctrl+Shift+L
Tips and Tricks...
Cheat Sheets... m
G Install New Software...
® Installation Details LPCXpresso (Free Edition) is fully
Q Display license type Welcome to LPCXpresso (Free Edition). The software is now fully
(Free Edition) can be used to generate and download applications
©4  Product Information
= Product Documentation
¥4 Support for using LPC
for usin
e Activate » | 5 Purchase from LPCXpresso Webstore v
#4  About LPCXpresso -- Free Edition — —
11 Create serial number and register (Free Edition)...
| 14 Activate (Free Edition)...
-- Pro Edition --
4 Activate (Pro Edition)... B":"":.’::x':
O Quickstart ... 52 | (= Variables| % Breakpoints| 3= Outline| 6 Expressions| = O © Deactivate (Pro Edition)...
B2 password reminder (Pro Edition)... bu can post, \
¥4 Start here i (o Check the following pages on LPCware.com for new NXP M
= announcements.
. Import project(s)
€] New project... ® L pen source and
o Build all projects [] # LPCXpresso support.
& Build " [] * LPCXpresso downloads.

7) JE—U/Jz Activation code ZRED{F1F. OK Z&ERUET .

Activate (Free Edition)...
Activate your product by entering your Activation Code

Activation code I01MQ-HSEU-C2B4-G31W-ERIR-OOA2-KSHX-MSMT

M ECEREEFE T T .
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7.5. B>TNWY—-RDFI>O—-REAL DR—b

BT —-RESATS U Github (CTABULTWLWET,
1) UF®DURLICFZIERALET.

https://github.com/vstoneofficial/Balancer2

2) HBT® Download ZIP Z#IRL. B> TIIL=Fo>0—-RUET,

O This repository Search Explore Gist Blog Help == ystoneofficial +~ & # P
: | vstoneofficial / Balancer2 @Unwatch~ 1 # Star 0  YFork 0

Balancer2( IBSHRFOETEWATYT . LpcXpresso@ll T4 757U —ATY, — Edit
<> Code
2 commits 1 branch 0 releases 1 contributor
@ Issues o

=3
branct ter ~ [+
2 branch- master Balancer2 i1 Pull Requests 0

Balancer2 W&HEIE

EE Wiki
e ystoneofficial authored 7 days ago latest commit e6520a0118 B
B Balancer2_firm_ADC_IX008 Balancer2 h#fiZ1E 7 days ago 4~ Pulse
I Balancer2_firm_Default Balancer2 WHEIE 7 days ago

fali Graphs
W Balancer2_firm_Simple Balancer2 WHiEE 7 days ago
B Balancer2_firm_Uart Balancer2 h#E1E 7 days ago 3 Settings

We recommend adding a README to this repository to help give people an overview of your
project

You can clone with HTTPS, SSH,
or Subversion. ®

[ Clone in Desktop

E?R _\ <> Download ZIP

3) LPCXpresso ZRd&. Quickstart /)LD >[Start here]>[Import project(s)]ZERLE T,

o= Outline'é‘}f Expressionsi = |

) Quickstart ... 2 ‘(x!= Variables\ 9 Breakpoints

FSmritere /- &R e
® Import project(s)J

[ej NeW project...| Import projects i

lais Build all projects []

& Build " []
& Clean " []
% Debug " []

& Edit " project settings

&% Import project(s) from XML Description
(2 Quick Settings v

B Export projects to archive (zip)

B Export projects and references to archive (zip)
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https://github.com/vstoneofficial/Balancer2

4) Project archive (zip)® Browse---Zi#RU. Fo>0O—RUE Zip J7 1)L ZEIRUET,

Import project(s)
Select the examples archive file to import. Y

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finish>. igj:R

Project archive (zip)
Archive [C:¥Users¥yokoyama¥DownIoads¥BaIancerz-master.zip

Project directory (unpacked)
Root directory

———s > O—RURE

LPCOpen is the recommended code base for many NXP LPC Microc - N
Download the LPCOpen package for your MCU and then import the, I7A) L%%;R
workspace by pressing the Browse button in the Project archive (zip) section, above.

. packages...

Import project(s)
Select a directory to search for existing Eclipse projects.

lancer2_firm_ADC_IX008 (Balancer2_firm_ADC_IX008)
lancer2_firm_Default (Balancer2_firm_Default)
lancer2_firm_Simple (Balancer2_firm_Simple)
lancer2_firm_Uart (Balancer2_firm_Uart)

SR

Options
[V Search for nested projects
[¥| Copy projects into workspace
Working sets

[C]1Add project to working sets

Working sets:

l Einish
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6) Project Exploer (C4 DO 10 MEIIENET,

File Edit Navigate Search Project Run Window Help
B-BRE|®~-Q B wpNENZ32IRL AL
(5 Project Explorer £2 |?,,_, Peripherals+|5‘-‘5? Registers! [E]g o=

b i5 Balancer2_firm_ADC_IX008:
» 5 Balancer2_firm_Default

i (5 Balancer2_firm_Simple

i (5 Balancer2_firm_Uart

() Quickstart ... 32 | (= Variables| ®% Breakpoints| 2= Outline| 6 Expressions| = B
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8. O IWY—-RADEI REET
ZCZTl OO MNIAR— U TILY —RDEIL R~EIA - BMEFESRZITLVET,

8.1. BTNV —RICDNT
BTV —RICETO 4 BENEFENET.
A) Balancer2_firm_Default
HERFD I 7 — LD 17T,
VS-C3 TOifit. OJDESRENEENFET,

B) Balancer2_firm_Simple
HIEL—TDHDZ > TINIR T 7 — LT T TY,

C) Balancer2_firm_Uart
UART /R— MO\SIREERIXIET BB TIL T,
Bluetooth E=1—J)L (VS-BT001) XEXEH L. PC TOJZREBLIEWEEICCSELLES
LYo

D) Balancer2_firm_ADC_IX008
IX7R— N7 FO0 ABsRAR— R (VS-IX008) Zi#EHtL. T BREDEEEISIH> TIL
T9Y,
TIHIREZBIMUILET DBE(CTEELES,
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8.2. B DIV —-RDEII R
AO>2O—-RUEYTILY —ZAZE)LRU. RAKICEZIADDIREC L. USBIRHTAIK(CESTIAH
*£9., CCTlE [Balancer2_firm_Uart]=Hl(CIRIESEZRBALE T,

1) BILRULEWBZTILZREET.

File Edit Navigate Search Project Run Window Help
B-HEE|®~-Q B Uz >eIRL L
{2 Project Explorer 53 |, Peripherals+‘3?5? Registers| B - = O

1 5 Balancer2_firm_ADC_IX008
» (5 Balancer2_firm_Default

&> palanicer 2_inii_sinipie

4 |5 Balancer2_firm_Uart

o= |7 me<

> (= Debug
b = Release
> & inc

> & lib

2) Quickstart /\=%)LdD>[Start here]>[Build Balancer2_firm_Uart [Debug]]=iEiRI &, EJL
ROMAEDZEYI, ([Balancer2_firm_Uart](37O> 1 MO T, O T MILDEFIN
ZHD%ETY)

() Quickstart ... 2 i(x>= Variables“ % Breakpointsi g= Outlineé 6t Expressionsg =

v Start here 2
# Import project(s)
1&] New project...

o Duildallarsiacts Inabus] / ig;R
lS Build ‘Balancer2_firm_Uart’ [Debug] |

¢ Clean 'Balancer2_firm_Uar| Build the project for the current configuration h
%s Debug 'Balancer2_firm_Uart' [Debug]
3 Edit 'Balancer2_firm_Uart’ project settings

¥ Import project(s) from XML Description

3 Quick Settings
B Export projects to archive (zip)
B Export projects and references to archive (zip)

¥4 Extras 2

3) BILRNETISBE. Console (C Build Finised EFRRESNET .

& Console 2 ?[f_ Problemsi i) Memoryl (® Profile+ ‘ 64" Data Watch+‘ @ Int Statistieﬁ-{i Int Trace+i ¥y, Host Stn‘ngs+| € Instruction TraceJ: = dm|
B EE & 2B
CDT Build Console [Balancer2_firm_Uart]
Performing post-build steps A
arm-none-eabi-size Balancer2 firm_Uart.axf; arm-none-eabi-size Balancer2_firm Uart.axf; arm-none-eabi-objcopy -O binary Balancer2_firm Uart.axf Balan
text data bss dec hex filename
26003 16 5336 3136@ 7a8@ Balancer2_firm Uart.axf
text data bss dec hex filename
26003 16 5336 31360 7a8@ Balancer2_firm Uart.axf
R
14:54:10 Build Finished (tock 547ms)
v
< >
L

NXP LPC1343 (Balancer2 firm Uart)
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XD—DANR=ZAFTOI7 AV RCBREBEBNEFENDHE. EILRIS—(CRJIGENHDFT.
Z0HE. UTOFIETT—DAR=R T A I DIGREEE L TIIZE,

1) C:¥Users¥/2&(C workspace T ALY ZVERRLET

Kb #E ER ~0
= & omn ) T srLLme - camac- BEzATER
w O B U X =l [ ove0s [§ @
/5203 - Tza-bavh 7 s BWIRRRR
- mhil BHEIE-% W &0 KL JONF4 BROUINE 2
(7] va-bhy roRDiF ” N Tox® - U lemE @
Dy Th~} g iR [ SR
®© « 1 b » PC» Windows (C:) » 1-Y- -

& BRIEAD
h 9950-F M el m " workspace
| [z llw

5 REFRUBMH

W& w-LIN-7

W pC

O J A IS =VERL L
HOUYIAZI—N5
0/« &<

3EOEE 1 EQEEHER KRR #E

2) IANSEEIUYOL. BFaUFT T Z2HEFET,

2% #8 | tFase| ezl

l ! ’workspace \ |
e SN ——
f==-H TP TANA— E*R
B C:¥Users
HAX: 01k

FAAYLOHAZ: 0k

A TV 0. IAS—8: 0
ek RES: 2014411870, 16:55:51
[RiE: BHBBA (I2I-NOI70H)(R)

ORI L) BERED).. |

ok || Fw EA(A)
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3) JIL—T&FEEI—Y—RICT[Everyone|Zi&R L. mEXHETET,

A | DREIRAX

ATS1IMG: C:¥Users¥workspace
I ~-T&ERFI-HF-&(G):
pr—

# Everyone

# Administrators«linux-pc¥Administrators)

8 Users (
1ER

TOEAS IR ZEE T3 [RE] &
99y

THUAFFEI(P): Everyone
)L 3> k0= .

= #1R
SHEDEET

IAI-ORBEN—EFRR

FeHED

Eand v

BTV R S AR AR RTBIC
& [(FRHERE] £OWILET, EERE(n

ok || w | mEm

4) J)La>bO-I)lZFTzvILU,. OKZERULET,

tEalTe

AT 4: C:¥Users¥workspace
O -T&FEFI-T-&(G):

i Everyone

83,SYSTEM

8 Administrators (linux-pc¥Administrators)
8, Users ( £Users)

| em@.. || EBE

T AFFEI(P): Everyone
) 3> k0=

=8

RHBDEET
TAI-ORBO—EFRR
FHED

1ooood

Fowl || EAA)
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5) OKZ#EIRLFET,

HRERAZ

ATT1Hh4%: C:¥Users¥workspace
I -TRERFI-T-&(G):

# Everyone

8,SYSTEM

#, Administrators (linux-pc¥Administrators)
8 Users ( £Users)

THEASFRIREE T3 [RE] £
VOPUH

THAFFEI(P): Everyone
) axbo-ib

=5

RHEDEELT
TANSI-ORBO—ERR
EHED

EcY

BRI S R E AR R I 21C
(. [FFHEERE] 20UvILET.

7 R

OK H Frol | BF(A)

6) LPCXpresso zZRdE. [File]>[Switch Workspace]>[Other:-- 172 &RUE T,
X]
File | Edit Source Refactor Navigate Search Project Run Window Help

New Alt+Shift+N» |2 X & @ & @ |

Open File... @ > =0
Close Ctrl+W
Close All Ctrl+Shift+W

Save Ctrl+S
Save As...

Save All Ctrl+Shift+S
Revert

Move...
Rename... F2

Z1 Refresh F5
Convert Line Delimiters To 4

& | Print... Ctrl+P

Switch Workspace » Other... I
Restart

Import...
Export...

EE

Properties Alt+Enter

1 control.c [Balancer2_firm_Uart/src]

2 Welcome [Welcome page] Expressions| ~ O [

Exit =
# Import project(s) 4

T~
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7) Browse ZIRU. SEFEERLIETAISTEERLET,

Select a workspace Browse:- %}Eﬁ U

LPCXpresso stores your projects in a folder called a workspace.

Choose a workspace folder to use for this session. IH) W%E}R

Workspace: C:¥Users¥workspace

» Copy Settings

8) 3.5.3)DFIET. BEY>IINY—R%ZA2iIR—KUET,
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8.3. YT IV —-RDEA
EILRUEB>TILY —R % USB BHTAKCEZTIAHFY.

1) USB&—JILzsL. KRD&EIRZ OFF [CLFET,

2) BERYEBEBUREEE. PCEUSBU—TJILTERLET,

3) USBOU—J)LaiEm Uz S FIRY D SFZE T .

4) 20 MIEER DL, PCHARREZE USB XEURELBIRC [NAXRX ML —2F)/)UAR] EUTER
WMUFRT. (WHTARERZ PC (CEELIBE. SREICUES <K-A/DMNDFET.)

O|UZFEZFICTD

®USB &—J)Lz
BRI UICORY

@QUSB =)Lz LIAD

5) CPU7/R— RMHPC (CFRHSMNBE. [CRP DISABLE] EWDSEIRD RSA TR TERRSINET,
CPUR—RZEEFEHRLILES N1 E1—4] ZRAWT. COEIDRSAITNRREIND &
=HRL. ATILOUYVIOULTRSATRBEEET.

N—F T1A28 F547

g TR 7 G

VL-WIN2 B EIBST A

.. DWD-RW B354 (D2 @ GRP DISABLD (E:)

[
il <
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6) [CRPDISABLE] ZR< &, H(C [firmware.bin] EWS T 7AILA—DAD TWEIDT., &

DI7AIVZHIBRUE T

B’547 v-lb

f-h #E &x s ve
wies) | mm Mgy b=RC » CRP DL.. v ¢ | CRPDISABLD (E:)0igZ AP
N\
L firmware.bin ‘
BIN J74IL
32.0KB
- e == = /\
HlIBR
1 EnEE =

7) JO>x U hTJAILFIAND Debug I AILA CYERR NI, [Balancer2_firm_Uart.bin]ZJE—
L. [CRP DISABLE] ARICRED{FIFTET,
SEDHBET AILS . Debug T4 IS (FLTFDIBARIC

[workspace¥Balancer2_firm_Uart¥D

ebug](C/ADFET,

bl = Debug
A-h #E Ex
@ v 1 | <« Balanc... » Debug v| ¢ | | Debughigzz
o LAIGNLSE £_UCUUY_1HSHLIU
LD J74
676 J{{~

JE—

L Balancer2_firm_Uart.axf 3_5
AXF T74 )l
217 KB

L Balancer2_firm_Uart.bin
BIN 771l
28.3 KB

.. Balancer2_firm_Uart.map
MAP J71 )l

=L HE ER
v~ 2 < » PC » CRPDI.. v| ¢ | | CRP DISABLD (E:)Dig%

132 KB

=
L makefile
Tr4l -

Balancer2_firm_Uart.bin
BIN 774l
28.3KB 1

1.55 KB

L. objects.mk
MK J71)
255 ){1

L sources.mk
MK J71)
419 )i/ b

1080EE 1EOEBDER 283K RTWR HE

\— DTS

1EnEE 1 EnEEZER 2838

8) AEMS USB U —J)LztheE, BEBRZAND E. ESIAARLTOTS AR D TRANENME

LEY,
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9. J\S5>YHY—2 SDK DfL#x
ZCZTlE IS5 =2 ZFHHIT BIEHDSA TS [JNS>H—2 SDK] OEARICDWLNT, B> T)LY
—A(Th> TR ULETY,

9.1. #iZ=5EA

[J\S>H—2 SDK] (&, O/Rw hd CPUR— R%Z PC hSBEBEFIHITDSATSUTY, MLHER
1B(d. Microsoft Visual C++7T. CPU/R— ROBHHEARS AT SUDREEMNS AT Y T ZFHHES
U. [E—5D8REN] 2D EHRDERIHAH ]| 12EZITNET .

9.2, EMFIRIR
RKSATSDOMERBEIUTDED T,

- OS : Windows XP SP3 Lp%/Vista/7/8

- XJFHSEE : Microsoft Visual C++ 6.0 L&
(> —TJ1—X:USB

9.3. Y2 TIWY—RICDNT
BTV —RICETD 4 BENEFENET.
A) Balancer2_SDK_Sample.cpp
SDK D& ZEZMICERALZY —-XO—-RTT,
B) BBO022HIDSDK.h
[J\S>H—2 SDK| DNV F—=T7AILTT, SDK ZFERAITDES(CHRBEERDET,
C) BB022HIDSDK.dII
[JN5>5—2SDK] MDLL I7A)LCT, SDKZERAITDEE(CHEELEIRDET,
D) BB022HIDSDK.lib
[J\S>H—2 SDK] DSATSUTY, SDKZFERAITDIEES(CHEERDET,
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9.4. YT WY —ADETHE
C CCld. Microsoft Visual Studio Express 2013 for Windows Desktop %z UT=Ei7/5 5% 557
UFEYT. HRERBCDOVWTIEATOUA AEDSFIO-RU. 1A R=)LZITD>TIIEEL,

http://www.visualstudio.com/ja-jp/products/visual-studio-express-vs.aspx

A) O SOYER
F 9. VisualStudio &R, FrLLWTO> U MMEERMRUET .

D'd AA— - /R—% - Microsoft Visual Studio Express 2013 for Windo
ot P i (e T (e i (D) e Frims (i il /L) TAR(S) -

B HLTOSIINE)... Ctri+shift+N | |
\ormrtms = Mo, — = = —— -

B FHLWIFILN)... Ctrl+N

B FOsiHEE(P)... Ctrl+Shift+0

2 TrAILERE(O)... Ctrl+0

ss 2013 f
SRR A

Y—-ASEHERI(0)
8 F-L FOSTIPAGEEM)...

RIS, D [>T L— K] > [VisualC++1 &&IRL. o 20O K] #%
IRUZEYI, F£fe. TO> 1T M TBalancer2Test] & AHD L. TOK] #IBUET .

FLLTOYIR ?

GrERRE: (HE HERS AYAb=IEd TI— OBE (Cirl- P~

B8R Visual C++
I FIV— 22 RR T A= 0T

o ~
[&] wins2 7osok OsIHhTT.
Ve e o T Tam mm mm mm mm
L v l | = _ 1
Visual C++ k EOTOSThk .
- v )
. o o o =
=5 Ol 7740 Fosmoh Visual Cas
TAR
Win32
SOL Server
Python
Visual Studio YJa—232
YT
b AT

[Balancer2Testl & A

A TTF AN~ PEEET AR, ToF I ILET.

—
LHiI(N): ﬁBaIancer2Test 1
B/RT(L): RSPV toME¥Documents¥Visual Studio 2013¥Projects

Va3 E(M): Balancer2Test
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http://www.visualstudio.com/ja-jp/products/visual-studio-express-vs.aspx

B) J7-JLDEM
BTNV -REDT7AI)ILZ2T O T MIBIMUET, ABICDWTIE83IEZIELLES
LYo

Ao>O-RULI7IL 27O NMIOE—-UF T, JE=EEFUTOED T,
[C:¥Users¥1—H&¥Documents¥Visual Studio 2013¥Projects
¥Balancer2Test¥Balancer2Test]
Ffe. JE=93T771I)LE83ETHBNULIZ4DDIF7AILTT,

Balancer2Test = B
#E =R - @
« Balancer2Test » Balancer2Test Balancer2TestMig=
’ ++ ++
- <@ E
Jries Home - Balancer2_SDK | Balancer2Test.c Balancer2Test.v  Balancer2Test.v
_Sample.cpp pp cXproj cxproj.filters
R ++
e I_—-I
CBBOZZHIDSDK CBBO022HIDSDK | | CBBO22HIDSDK ReadMe.txt
_OS (C:) .h lib
T{ZU ‘ j [ [I_':"i'
WhEAR stdafx.cpp stdafx.h targetverh

nTR-3a

V1—23>IORTO-5—DEEZFRRSEFT. ROMLAER YV—-IL>V)1—-23
SIORTO-S—] ZHITLETEFY. BICRRESN TV BIBEETOFEFRRSEFT,

Wa-zay TH270-5—

— Hecsle-2an s

Yl1—2ay THZT0-5— DEE (Ctrl+:) P-

YA —fo

] Y1—-Za3> ‘Balancer2Test' (1 JOTTHR)
4 [%] Balancer2Test
4 Y= Tl
B ++ Balancer2Test.cpp
++ stdafx.cpp
4 L] ~wE= JRAL

|
|
|
|
. B stdafch
I
|
|

—OLY4T ZEA-Thf

c

B targetverh

U2 T4l

b iE FHEMEEFEE
B ReadMe.txt

Wayg -

3

- e e e e e e Em Em =
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VU1—23>IoRTO-5—0 [V-RIT7AIL] 2HOVUvOUL. EN>EFDIER] =
DIvOUEY,

Jfwnsz J| iR = el

YUi—-3y THAT0-5— T aX
Glo-2am| 5=

Ya—iay THAT0-5— O (Ctrl+:) R -

R YUi-z3y 'Balancer2Test' (1 JOYTHE)
4 [%] Balancer2Test

[BfFDIEE |
ZERT D

1B00(D) r

b ++ Balancer2Test.q ~
++ stdafx.cpp B H3Z UeH—F(Z)... Ctrl+Shift+X e I
4 o oraE—- TRl - .
B stdafxh | CCFTRE(S) o
B targetverh FA V1—2a> THAT0-5— OE1—(N) ¥ 43A(C)... Shift+Alt+C
Y= IR M tI0EN(T) Ctrl+X
b E SEMTTREE o ak—(y) Ctr+C
B ReadMe.txt BER () Ctri+V
X El(D) Del
T EEIOEE(M) F2
JO/F4(R)

[Balancer2_SDK_Sample.cppl ZiBNMULZE T,

EX/FIEEMIENN - Balance
[Balancer2_SDK_Sample.cpp

| Z#IRT D

« Balancer.. » Balancer2Test

AL~

~ zm o &2
- | ++ Balancer2_SDK_Sample.cpp ' 2014/11/18 11:45 C++ Sourc
D e i SRcCRT PGt — — — 2014/11/18 12:20 C++ Sourc
%] Balancer2Test.voxproj 2014/11/18 12:20 VC++ Proje
£1 Balancer2Test.vcxproj.filters 2014/11/18 12:20  VC++ Proj
| ceBO2ZHIDSDK.AII 2014/11/18 11:34 FFUbr—2a3
CBB022HIDSDK.h 2014/11/18 9:54 C/C++ Hee
B CBBOZZHIDSDK.lib 2014/11/18 11:34  Source Broy
%) | ReadMe.txt 2014/11/18 12:20 FTFAF FFa
st ++ stdafx.cpp 2014/11/18 12:20 C++ Sourc
stdaf.h 2014/11/18 12:20 C/C++ Hes
targetverh 2014/11/18 12:20 C/C++ Heg
v < b3

JrAILE(N): Balancer_SDK_Sample.cpp v

COFIREARRIC, VI1—-23>TOXTO-5—DINVI-T7A1)L] 250Uy IUL. [1B
m>BiFDIER ] T [CBB022HIDSDK.h] ZEMULFET .
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C) FHTI7AILDiLE
IV —23>V T e EIL R ERRICERULET.

[\ I>/)\wIRE] =20 Jwv 03202V —)LEEMINE T,

| BalanceraTest - Microsoft Visual St-- Y3 & 715 : Pl - .
(LF) #EE£(E) Z=R(V) JOIIMP)  ELEE) | FIWHD) | F-am)
M) FAMS)  D4PFIW)  AULT(H) O . e e e e
2-0 @S B[P - | b OALWN ) 7semes) F5
= ra ) . oyt
3alancer2Test I o-s za-n)| & TOEREFHFP)...
-ﬁ Sf-%i‘ifx-cpp : %-ET}&?%G F Bala'PcEréTw ZOMDT Il S—4wl
ELU-R 2F AT A LER :
77 stoafx.oh) D132 U 30 L FRRIERY  PHX Ctri+D, E
include “stdafx.h™ G. 1'7'9':{ 12A1) F11
. & 23w A-)(—(0) F10
=47 TOD0: T 7 M3 75 < . BTDAFK.H T4k ——
7 s B2RLRCEE I T S moromemme R

JL—4itA = OAERE(B)

b C:¥Users¥vstone¥Documents¥Vis... ~ ':'
' ot failed

FREEH U TULRWNES, BIEROKLDS
(C [Connect failed] &FRRESNET,

Fle, KEHROFF 1I0WHRBTDE
[ Connection timed out] &XRRxSNT
TV —2 3> VT MR TEINET,
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D) B> TIILTO0S LADME
>V —)LBEEZERVWEIREE T, /(5282 EDiESEFB ERD. KIEHRDBS [Connect failed] &
FRSNZET ., EHELUIEIBS [Connect] EFRSN., TOTFICONY ROFIANTRRESNE T,

- O ®
' C:¥Users¥vstone¥Documents... -

Connect failed

ON> RDOANTTHEILLTFOED TY,

° lcl
CPU/R— REDBIEZRIRT D
° fd]

CPU 7/R— R EDBIEE M T D

o [r [FRLZ(16#%R)] [U-rX(16E%)] |
AEURYITIDT RLANS YA XDDT —H % HHFHAD

o [w[B][7RLZ(16#%R)] [ME(10 EE)]]
AEURYIDT RLANSE(CENDTETZEZ RAM (CEZIAD

XBIDIBTEFEE. [sb(byte)l Isw(word)] [sl(long] Tub(ubyte)l luw(uword)! lul(ulong)]
DNITNHDE 2 XFE AN UET,
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o [f il
Flash ROM Z#JHPRRE(C L E T
e [f ml
RAM MOHE% Flash ROM (CEZEIAHZFE T, Flash ROM (CEEZTIADZET. AMRDERZY > TH
ETAATZREBIFTEZFE A
o J[e]
7IU—23> VI NEETUET,

9.5. B DR A
SATSUChEn> TS BEBOEEFIUTDED T,

+ int CWRC_Connect(USHORT pid)

CPUR—REBEZHIBLET. EDMEIE. EUSBEZMABTENE 1. CPUR—RARDNSR
W FEttoTO0 S AEBICBELUTVRRECKDBEZRMIATE/RAINE 0 ZRUET, 5l
& JOFOKIDZ5Z%FT.

- void CWRC_Disconnect()
CPUR— REDBEZETUEY,

- int CWRC_ReadMemMap(int staddr, int sz)

CPU MR— RO\SFTHADAEIRY TDT RLRAZIBELET . ERICHRMAAHZITIRDOD(E
ReadExecute Bz EITUIZEETTY, 5lE(. 'int staddr' ([CFHRAHAAERIETDAETISRYV I 7 RL
A, int sZ' (CERAHADATIH A X (byte i) Z25XF 9., RDMEE. Connect BEZERITLTLVR
L FREAETURY TOEHENDT RLRZIEE LIcizE(d 0. TNSDEER 1 &#RUET,

XEURYIDO7 RLZABEE, 10710 [SATSUXEUIVT] 28R L TIZE),

- int CWRC_ReadExecute()

ReadMemMap B TIBE L7 RL X% CPU /R— RW\S5i#HAFH. S TSURIDATEUTYSE
IREEFUEIT. RDMEE. Connect BIFZEEITUTULVRL, FREEATFUIY TOEENDT KL X
EIBEURBEIZ 0. ZTNLUDBEEE 1 ZRUET,
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« int CWRC_WriteMemMap(int staddr,BYTE data)

CPUR—RDOAEUR YT ICESADT —FZ2tzy hUFET, RRICEBSAHZITIRDDE
WriteExecute BA#ZEETUIEEETY . 58U, 'int staddr'(C(FFT—FEEZTIAD T RL- X, 'BYTE
data'lCld. ESALHEE (byte Hfi) &, TNETNE5XFT,

RDfBE(E. Connect BAEZEEITUTULVRAL, FEEAXATBUI Y ITDOHESNDT RLAZIBELTHES
(0. TNV DIZER 1 ZRUET,

2byte DEFEHFEULAETY IOV U ICHEZEZTADHEF. LAUA b FU\A R ECHITT2
EIRAEZEERITLU T IZEW. F£fze CPUR—RDINA hA—F—-FEVI T FT 172Dz, BESDIN
UMD RLAMS Ao hZEIDHTTLLIZE,

+ int CWRC_WriteExecute()
WriteMemMap B3ETIETE L7277 RL X% CPU IR— RWN\SFHMAFH. ST SURAIDAEUR W T1E
wzEEFLUEXRIT. RDMEE. KBRUEHBEE 0] ARIHUEBSE 1] ZRUET,

- int CWRC_FlashExecute()
WriteExecute BAZICTEFH U XTEVU Y J1E#R%Z RAM H'5 FlashROM AN EEmX UE T, EDE(L.
LRUEBZEL 0], L iEESE 1] ZRUET,

+ int CWRC_InitializeExecute()
AFBUY T DWHERE#HRZ FlashROM (CEFAHE T . EDfEIX. Connect BEZEEITL TLVRLY,
FEATURY TDEFRNDT RLAZIBEUEESE 0. TNLADBEF 1 ZRUET,

- char GetMem_SByte(UWORD adr)
AXEUY IWSFSA char (1byte) DIEHRZEUSLE T . 51#(d. " UWORD adr’([CIFFRMHAD T
RLRESZFEYT, RDMEE. HAHAARAETIRY TOBETY .,

- short GetMem_SWord(UWORD adr)

AXEURY I SFSAT short (2byte) DIEHRZEUSLEI . 51#E. ' UWORD adr'(C(FFHAHAD
P RLRAZSZFT. 7 RLXA(&E 2byte D55 LI byte D77 RLRAZIBELF T . RDOEIZE. FidAA
RAEURYTDHIETT .

59



+ long GetMem_SLong(UWORD adr)

AEURYITHSFHSAT long (4byte) DIEHRZEUSLET . 518, " UWORD adr'(C(35AHAL T
RLRAZS5XFT. 7L X(F 4byte DSEE LI byte D7 RLAZIBELEF T, ROMEF. FdrAi
EAEURY T DEETT .

- long long GetMem_SLongLong(UWORD adr)

AEURY TN SFSHT long long (8byte) DIBEHREZEUSLFET . 518(E. ' UWORD adr'(C(FFkdH+
AT RLRZS5ZXFT. 7 BL X3 8byte DSE&F il byte D7 RLAZIBELFI . RDME. F
HARWTEAEIYIY TDHIETT.

- BYTE GetMem_UByte(UWORD adr)
AEURY TINSFRISEL char (1byte) DIBEHREEUSUE T . 518(E. ' UWORD adr’(C(F5RAHAD
PRLRZSZFEY, RDEIE. SHAHAARATIRY TOBIETY .

- unsigned short GetMem_UWord(UWORD adr)

AEBURY TIHSFSEL short (2byte) DIBEFHREEUSUE T . 51EE. ' UWORD adr'(C(FERdHA
DTV RLRZEZEZFT, 7L R(E 2byte DS 5 Lfiibyte D7 RLUAZIEEULFE T RDIER, Fdnd
ATZEAEBIURY TDOEIETT .

- unsigned long GetMem_ULong(UWORD adr)

RXEURYINSFHSHEL long (4byte) DIBEHREEUSLE T, 5. ' UWORD adr'(CIFFHwMHAD
7 RLRAZSERET ., 77 RLX(F 4byte DS EE I byte D7 RLRAZHEELF T RDIEIL. Fidrd
ATEAEBIURY TDEETT .

- unsigned long long GetMem_ULongLong(UWORD adr)

AEBUNYVINSHEEL long long (8byte) MIEHRZEUSUE I . 51EKE. ' UWORD adr'(C (5
HFADT RLRAZERFET, 77 RLR(F 8byte DS E& Efilbyte D7 RLAZIEELF T, RDIEIF.
RAAATEAEIRY TOEIETT .
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- float GetMem_Float(UWORD adr)
AXEURY TN SFENERE float (4byte) DIBEREZEUSLET . 518E. 'UWORD adr'(C (355
ADT7 RLRAZE5ZXFT . 7 RLR(F 4byte DD 5 i byte D7 RLRAZIEELF T . BEDIEL. &
FHAATEAEURY TOEIETT

- double GetMem_Double(UWORD adr)

AFBURY TN SFENERE double (8byte) MDIBIREEUSLET . 51EKE. 'UWORD adr'(C(F5HE
HFADT RLAZE5RFT, 77 RLR(E 8byte DS 5& LI byte D7 RLAZIEELFI . RDIEIF.
FARAATEARAEURY TDEIET T,

+ int SetMem_SByte(UWORD adr, char data)

AFBURYVIDIBEDT RL R, FF51F char (1byte) DEHRESZIAHET . 51E(%. 'UWORD
adr'(C(FFRAHAD T RL X%, ‘char data'([CIFEEZT AT —HFDEHZ5XFI. EDMEIE. Connect
BT U TUVRL FIZEATYU Y TOFEESNDT KL AZBE UIHE(E 0. 2N DIEE(G
17ZRUET,

« int SetMem_SWord(UWORD adr, short data)

AFBURYVIDIBEDT RLR(C. 5547 short (2byte) DIFHREESTIAHET . 512, ' UWORD
adr'(CIFFHmMHAD T RL A%, ‘short data’ (C(FEZTADT —HFDEHZSZFET. 77 RL X 2byte D
S5 il byte D77 RLAZIEELE I, RDMEIE. Connect BEZEEITUTULVRL, £EAETUYY
TOEENDT RLREEBEUZHBE(E 0. TNUNDBEEF 1 ZRUET,

+ int SetMem_SLong(UWORD adr, long data)

AEBURY ITDIBEDT RLRIC, 511 long (4byte) DIFHRZEEZIAHE T, 51#(d. "' UWORD
adr’(C(EEFRMHAD T RL X%, 'long data'(C(FEZIADT —FDEHZE5ZXFI, 7 RL XS 4byte D
SHE5& i byte D7 RLRXZIBELE T, RDIEE. Connect BEEEITUTLVARL, FREAETUY
v T DEFENDT RLAZEBELUBEF 0. TNEBOHBE 1 ZRUET,
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« int SetMem_SLongLong(UWORD adr, long long data)

AEURY TDIBEDT RLRIC. 511 long long (8byte) DiEHREE ZIAHE T, 512" UWORD
adr’(C(EEFRHAD 7 RL- A%, 'long long data’ (CFEZFIADT —IDEHES X F£9 . 7 RL- X (& 8byte
D55 I byte DV RLRAZIBELEF T . EDENE. Connect B#ZEITL TULVRLY, KE(EAEY
RV T OEENDY RLRZIBE UIHBE(E 0. TN DBEF 1 ZRUET,

+ int SetMem_UByte(UWORD adr, BYTE data)

AXEURYITDIEEDT RLXIC, FSELU char (1byte) DIEHRZZEZIAHE T . 5l#(E. ' UWORD
adr'(C(FFRAHAL T RL X%, 'BYTE data’(CFEZTIADT —HYDEH=ZE5XF I, RDMEIE. Connect
BT U TUVRL FIZEATYU Y TOFEEINDT KL AZIBTE UTIBE(E 0. 2N DS
1 7ZRUFET,

« int SetMem_UWord(UWORD adr, unsigned short data)

AEBURY TDIBEDT RLRIC, FSEU short (2byte) DIEHREEZIAHFE T, 5%, " UWORD
adr'(C(FFEMHAD 77 RL- A%, ‘unsigned short data’([CIFESFIADT —YDEHEE5XFI. 7RLX
(& 2byte D55 LI byte D7 RLAZIBEULF T . EDME(E. Connect B#EZEITLTULVRL, FfE
(EXEBURY TDHEHFENDT RLAZIBE UBEE(E 0. TNEWDIBEF 1 ZIRUET .

- int SetMem_ULong(UWORD adr, unsigned long data)

XEURYITDIEEDT RLAIC, FSE&LU long (4byte) DIEHRZEZEZTIAHET, 51#(E. ' UWORD
adr'(C(3FRMHAD T RL- A%, ‘unsigned long data’ (C(EFEZADT —HFDERESZFI. 7RLAZ
4byte DS E&\ LI byte D7 RLRZIBELFE T, RDMEIE. Connect BA#ZEEITL TULVRL., F£2&
AEUY TOHENDT RLAZIBEULBE(E 0. NS DBEF 1 ZIRUETD,

+ int SetMem_ULongLong(UWORD adr, unsigned long long data)

AFBUIVIDIBEDT RLX(C, FSEL long long (8byte) DIBEHREEZFIAHET . 5IEL. 7
UWORD adr'(C(35xAD 7 RL- A%, ‘unsigned long long data’(C (B FIADT —IDERBES X F
I, 7RLX(ZE8byte DB LI byte D77 RLAZIBELE T, BDMEIE. Connect BEZ==EITL
TV, FZEAEBURYITOHBENDY RLAZEE LULHZEE 0. TNLVDIBE(F 1 ZRUE
ER
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- int SetMem_Float(UWORD adr, float data)

AEURYITDIBEDT RLRIC, F8\# =B float (4byte) DIFEHREEZTIAFET, 5IEUZ.
UWORD adr'(C(FFHHAD T RL X%, ‘float data’([CIFEZADT —FDEHZS5ZFT. 7 RLR(E
8byte WD BE Ll byte D77 RL RAZIEELF T, EDE(E. Connect BEZFEITL TLVRL, FzlE
XEUY TOEHEVIDT RLAZIBE UILBEE 0. TNV DEEF 1 ZIRUE T,

+ int SetMem_Double(UWORD adr, double data)

AEBURY TDIBEDT RLXI(C, ZF8ERE double (8byte) DIBEHREEZTIAHFET . 518, ’
UWORD adr'(C(F&FRHAD T KL X%, 'double data’(C(FEEFIADT —HFDEHES5ZFI., 7 RLX
(& 8byte DS EE LI byte D77 RLRZIBELET . EDMEIEX. Connect BEZEITUTLVARL., F
REXEURY TOEHENDT RLRZEE LUHBEF 0. TNMDBE 1 ZRUET,

9.6. XEUIYYITDEIE

CPUR—RDAEUNYYVTF10.7B [SATSUATUIR YT ] ZZSSBIZEV. XEBUY T,
T RLRAICED THAXPHESNBIELTHED. Fe. ABZEZTIRX 52 & T CPUR— ROFHWENZE
T DBENHDET ., BEU CPUNR— ROREBZTICRERIRDIZE. 7T8ZEZE(CT7—LD1)
ZESBELTLIZE0,
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10.

NSO a—-F12D

10.1. F&KICDWT

Q1.
Al.

A2.
A3.

Q2.

Al.
A2.

Q3.

Al.
A2,
A3.
A4.

10.

BWRHA 5720

B (CRBELDVRVDEERL TF S0,
BHEHLLVED (KBEOBE. BREDED) ZHHENTIN ?

ABER(LE 3 TILH VLB ($HE 3 =y SILKRBROH G L TBDET, 78
CEHELTEOER A

BNITERV. FEBERIHREE

BFAVDBEONZWEED. BUNELRVGER, EULHIHTDZENTEEEA

AV OREHREOBEGH 0.5mm LIFICRBKRDCULTLESV, (FEZF5RAEDOFIE 10 =2
R <IEE0N.)

E—SEHES/EN

AR, ENCEBMMIMITUESIZENSBDFT, BUNEULSAD TLDIMNTHERITE S0,
—EBHZEIMDHL. BEANBELTH TS,

E—YDIFFENEMRTIEL TLDIMMER L TR,

AL THCE—YDiFFaRIRNE, BIREDEMARICKDE—INEERURWNEENSD
NFET, HIFRAZEOFIE 04 BFNSPHEL TS,

2. \5>59—-270957ICDW\WT

[I\S>285-27005%] NEULKEEULIRVMEE}. UTOEBEZIHERSIZSV. TN TERR
URWMBER. RF2 A MRED REICEATDIHBNEDE ] OERECSBVEDE STZEU).

Q4.

Al.

Q5.
Al.

USB &r—TJI)L&IELTVSH, IRMFEREOE LD [KiEHE] ORROFFEDSHL
USB o —JILZBEUEBELTHHR L ZEV, ZNTEHE LRGSR USBT—TILEZERTH
UTFEL.

MHEFE— K] TRAF—ZHU TV, I\S 25 —2 KEHEHIR
2.5 2RO L BRIFE—RIDOF TV IRY IRICFTYVINADTVNDINZEZHRSTZS N,
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Q6./\5>5—2 ZEFESETE. I<ICANTLES

Al.

Q7.
Al.

Qs.
Al

Qo.
Al. B
A2.
A3.

BEFHECUTHEHEU TSV, ENTEENTUERIHZEE, T >ZYHMECLUTHRHU TS
LYo

X > RX R—=)L5E (C:¥Program Files (x86)¥Balancer2Programmer) ®H(C. [init_gain.b2g]
NHdDT, 41618 54> DFuA] ZTHBD L. [T7AILSFHA] R ZHU.
[init_gain.b2g] ZFEMHAAT. [PC->RAM] Z#H L. €D [RAM->ROM] /R ZHI &
THHMBEICRDZET,

BHhIS IICRRESNWN
BEA LD T8l (CIR>TWLWBH. Fie, 23 5THROLE, S5 IJRFKRSETLIEEL,

O 07 —49BRETER, FzF, ERERMEDEZTATNRN
RAMRBEDHEE L. [OJHT>7] FTUhOIMRFCEFRA, T THERSIIZS0N,

DX REEIUYIUT, ERESTRIDICENTERN

Al (char %) ([CEDEBHNCHERIZELN,

I (short &) (CEFEL(0.1 F)Z AN U TULVRWNDTHER S 20N,
PANFNESENTUVRVWNTHRTZE0,

Q10. NS>H—2hEIULRLBOE - BFLIR< DT

Al.
A2.
A3.

B (char %) (CE&EDFENCHEERIEEV,
XA (short &) (CEEEL(0.1 H)ZE AN U TULVRWHTHEER S IEE0)N,
LANFENEFNTULRONTHERLSZSU,
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11. &%
11.1. SvrOt> Ytk
A) BiF AMHEE/EFRR  ENC-03RC/D
B) #&HHEGH +1.667 it [rad/sec] (£300[deg/sec])
C) SfiRkE 0.006680465 [rad/sec] (1.202483675[deg/sec])
D) BHUS/EHA 2[msec]
11.2. O—%VU—I>1—5 %
A) EEgRGELL 21:1 (E—FEEe2[mm]. 51 77Ep42mm)
B) f%RE 0.01246664[rad/sec]
C) =ARBRHEE 100[kpps]
11.3. EFEEIEMLER
A) BFARESMEE  1.61133[mA]
B) HIEHIEHA 1[msec]
C) JOvU#RK
BRIES 1P TSR

it)

i(t)
o(b)
Gp
Gi

" o(t)
%T%D—) Gi

v
i
\r
\

BREDE (XEUST YT 8,10 #ith)
E—SYERAEE (AEUI VT 4,6 Fith)
BRI PS> (AEVUT W 288 Hith)
BRET I > (AEU YT 296 FHith)
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11.4. 1iEE

BHMIE
ERTLENS X : O[mm] Y : 74.5[mm)]

164 44 156.44

@2.00

@ (1]

@

S 1o -7 p—
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11.5.70v VK

USB LPC-Link 121 12C,UART IXRT4
dxRDH axr05 ZNE) > (CN9)
(CN1) (CN4)
- T—l PAD PADORDS
(CN10)
L Sv oY
— (ENC-03R)
MCU :
S (LPC1343) ™ E
W a AD>)\—%
ATYTF e (12bit)
X2

pcE—% ||0-5u—| [0=5u—|[ pcE—%
(FA-13059«F) [| T>1—4 I>3—4 [ (FA-13051F)
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11.6. #isRIRI 5
A) CN9 (IX O®U%H)
I12C - UART #2872 5K 9 DRICERATE S IRITI T,
Bt RONLERR— RZEA T DHE. BISEOT M0 505+ I5v M=) (E&EH) ] =22
ERLIEE0,

1:TXD(UART) 6:SDA(12C)
2:RXD(UART) 7:Vbat
3:NC 8:+5v
4:NC 9:+3.3v
5:SCL(I12C) 10:GND

B) CN10 (PAD J%%)
VS-C3 BA/R— NIIRRDET, I TOTSLADSHMERTETERA.

C) CN4 (LPC-Link)

NXP ##5/Vw#  LPC-Link 283 3/edDIRISITY,

ORI EERESNTEDEFADT. IST & S8B-ZR-SM3A ZEE\ZIE< . —TILZIFALE
DIFLTHEN &N,

1:3.3v 5:NC
2:SWDIO 6:RESET
3:SWCLK 7:NC
4:SWO 8:GND
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11.7. SATSUXEUIVT

Tiem 27 o P Rw | o %

0 A% 4skD Product ID unsigned short 2 R 0x2080
2 /7\7_;'/;217 Version unsigned char 1 R 1
3 E—F MODE unsigned char 1 R 0 ?i:g%ﬁg;F
4 [E-AERAEE M GURRENT L short 2 R 0{mA
6 M_CURRENT R short 2 R 0
8 |E—SERETIERE T GURRENT L short 2 R 0{mA
10 T_CURRENT R short 2 R 0
12 |ERA7Evk CURRENT OFFSET L short 2 R 0|lmA
14 CURRENT OFFSET R short 2 R 0
16 | AAKRAEE BODY_ANGULAR SPD double 8 R 00 |rad/sec
24 | KREAE BODY ANGLE double 8 R 00 [rad
32 |KEBREREATEIH BODY ANGULAR SPD OFFSET  |double 8 R 00 [rad/sec
40 |RA—ILARE & WHEEL ANGULAR SPD L double 8 R 00 [rad/sec
48 |RA—ILARE A WHEEL ANGULAR SPD R double 8 R 00 |rad/sec
56 |Thf—ILAE £ WHEEL ANGLE L double 8 R 0.0 |rad
64 |Thf—ILAE & WHEEL ANGLE R double 8 R 0.0 |rad
72 |BREEE TSPDL double 8 |R/W 00 |rad/sec
80 TSPDR double 8 | R/W 00
88 |T a—4 ENCL long long 8 R O[4EEDE
96 ENCR long long 8 R 0
104 |Uv4A GYRO DATA short 2 R 0|>v4A4Bt>Y ADCT—4
106 |ADC(Eif) ADC G LA unsigned short | 2 R 0| E—4EiRfE ADCT—%
108 ADCCLB unsigned short 2 R 0
110 ADC_.CRA unsigned short 2 R 0
112 ADC.CRB unsigned short 2 R 0
114 |vs-c3 PAD BTN unsigned short | 2 | R ol o le| 'O’El 'Ail 'Fffl‘t'flaR'szL';”*
116 PAD_ANRX char 1 R 0[-1277128
117 PADANRY char 1 R 0[-1277128
118 PAD AN.LX char 1 R 0[-1277128
119 PADANLY char 1 R 0[-1277128

. T7—LOI 7L EEDOHIEES
120 |2—¥TU7? USER ARIAT double 8 |R/W 00 Jj% %E;;E ThoRRORKIEES

A OERFOUSBREATHIEEZE=
128 USER ARIA2 double 8 R/W 0.0 93‘/;{1?:“&%[?;3%?%_%
136 USER ARIA3 double 8 R/W 00
144 USER ARIA4 double 8 R/W 0.0
152 USER ARIAS double 8 R/W 00
160 USER ARIAG double _ 8 R/W 00
VAYJ

168 USER ARIA7 double 8 R/W 00
176 USER ARIA8 double 8 R/W 00




TRLAR

HA4X

0 Eidll R Il
0 £ il (byte) /W | #HEAE 23
184 |F+¥UJL—3y CALIBRATISON.CNT unsigned short
VAL N .
K 2 _|R/W 0|FvIL—avAhovs
186 |F+¥UJL—>3> CALIBRATISON_TIME unsigned char
i | Rw 5l % vyTL—sas BT 5mm
187 |@%'MODE LOGMODE unsigned char
BO: RECODIONG /BRIt vk,
BRTBICBEMIZIUT
B1: RESET /A5 AAEUEIVT
B7: ENABLE /05 EE%E31t
O4 FAEY [ZROMEMBA AT LFE
— DT, ROMEBREITSLEESN
)
BOZt v kL TROMIZZWVTHITIZL.
1 | R/W O|BNEBIRER MO0V EMBTES
188 |05 Divider LOGDIV unsigned short SEME  500/(LOG DIV)HzCERE
77 )= _ z Si
2 R/W 110: 2% 1:500Hz 10:50Hz
190 A5 A4 LOGONT unsigned short | 5 | R/w 0|B5HH Sbyte$)
192 |AYI5Y e unsigned AEYTYT DT EL R0 (Obit) ~
long | A
one fone 6354 (63bit) EREFT AN BE.
8 | R/wW 0|1: B3, 0: &3
LOGFLG2 1 d
200 ron:g'glr;ig AEYTYT DT KL R64%H (Obit)
~127% 1t (63bit) Z{R7FT SN R
8 |R/W O|FE. 1:B%.0: &M
LOGFLG3 i d
208 fonnsg'glr;g AEYTYT DT RLR128%H (Obit)
~191& 1t (63bit) {RF T DMK
8 | R/wW 0|E. 1:H%.0:EY
21 6 ﬁlll'zﬂ%lﬁﬁﬂ’f’(‘/ GAINBODY double 8 R/W 10 2&12';}7‘-,(:/
224 GAIN WHEEL double 8 R/W 10 9’(*”72’{\J
232 GAIN WHEEL CORRELATION double 8 R/W 10 |54 1B 5 1>
240 GAIN.BODY ANGLE double 8 R/W | -364000 |AthsE
248 GAIN.BODY ANGULAR SPD double 8 R/W 54600 | Atk ERE
256 CAINMHEELANGLE double 8 | R/wW 13200 |4V AE
264 GAIN WHEEL ANGULAR SPD double 8 R/W 3960 |44 FRE
272 GAIN WHEEL CORRELATIONANG [ double
LE
8 |RrR/w 24000 |EESA VR AERE
280 GAINWHEEL. double
CORRELATION_ANGULAR_SPD
8 |RrR/w 3600 |EE2A VR ARERE
288 |E—AERFIET 1> GAIN CURRENT P double 8 |rw| 000023 |Prqe
296 GAIN.CURRENT! double 8 | R/W]| 001200 [I54>
304 |JvAOHPFRE GAIN.GYRO HPF.COF double 8 | R/W| 099950 |4 OHPF{REK
312 [ATvaFFqay GAIN OPTIONI double
A—YHEBEDEIHEMERLESTS
BRIz, {EEIZH 1> %FlashRom|ZEE
8 R/W 00 |BEEARIENTED
320 GAIN_OPTION2 doub|e 8 R/W OO
328 GAIN.OPTION3 double 8 R/W 00
336 GAIN OPTION4 double 8 R/W 00
344 GAIN_OPTIONS doub|e 71 8 R/W 00
352 GAIN_OPTION6 double 8 R/W 00




11.8. SIS UDEE

11.8.1. @

® void Balancer2Init();
#IEAML
51%% AN
RiE N

® void setLED(unsigned char value);

LED s24T
5128 value bit0 : AL > LED , bitl: 7R LED
=i xU

® unsigned char CycleProc();

[EV RN
5128 ANV
RiBE 0 : {F1EHH 1: B+

® unsigned char getSW();

AW FAREEEUS
51#8 U
RIE 1:#F

® void Wait(unsigned int msec);

e
51%% msec F5E/%Z msec EAI TIEE
R=—AE N
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11.8.2. Senser

void CurrentControlEnable();

B HIEEN
51#8 U
RIE ANV

void CurrentControlDisable();
Em IR

5128 U
RI& U

void ClearEncVariables();
T> -5 RAZEIEME

512K AN,

=i AN

void ClearCurrentVariables();

BRHHRZEFIHAL
51#8 U
RIE ANV

void ClearGyroVariables();
Sy Ot YHAZEYIEME

5128 U
RIE ANV
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11.8.3. Log
® void LogStart();

O ESRIA
51%% NS
RiE NG

® void LogStop();

OJEUSHET
5128 U
RI& U

® unsigned char isLogRecoding();

OJESHH iR
51%8 U
RIE 0 : {F1EHH 1: BfEH

® unsigned char isLogEnable();
OJE— RO B VHERR
51%% AN,
RIE 0: 83 1:B%

® void setLogEnable();
OJE— Rz2BMICHE
5124 ANV
R AN

® void setLogDisable();
OJE— RESEN(THTE
51£8 N
] AN

® void setLogFlag(unsigned char * val , unsigned short size);
OJJS0%RE
5128 *val  RETDIEHEAETURYITEHZ
(memmap.values.BODY_ANGLE) 72fsX TIEZE.
Size  ZED)\A MR
(] ANV,

Al
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void clearLogFlagAll();

OJ230%0U7%7
5128 AN
RIE AN

11.8.4. ADC VS-IX008B

® unsigned short getIX@@8(unsigned char num);
VS-IX008 m'5 ADC 7 —4~HUS
51%8 num R— &S [0~7]
=i 12bitADC > —4 [0~4095]
11.8.5. UART
® void UARTInit(unsigned long baudrate, unsigned char parity , unsigned char stop);
UART FJHRERTE
5124 baudrate R—L— hZ&E [51]25F eBoardRate H*53&iR]
parity J\UZF 1 59T [5I1Z2F eParity H'53&1R]
stop AbhvTEY NEE [1or2]
RIE AN
® void UARTSendByte(unsigned char data);
151 MXfE
5125 data INA =4
RIE AN
® unsigned char UARTReadByte(unsigned char *data);
151 MxfE
5128 *data RAET — AR EDINRA >4
RiB 0:ZEF7 12U 1:RME7—9H0D
® void UARTSend(unsigned char *BufferPtr, unsigned long Length);

B o NXAE

51%% *BufferPtr KET —FEFIDIRA >4
Length XET—FEIIDES
=B AN
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® void UARTTrace(char *BufferPtr);
L —XE (CR+LF O— RZzBEafRE)

5128 *BufferPtr XEXFHNDIRA >
RIE ANV
= XFHREDY¥OFTZEEXMEL., TI— FERIEITXE

11.8.6. E—7 it
® void SetMotorPwm(int ml, int m2);
E—H\D PWM 1EERTE

51%K m1l,m2 E—5\DPWM #545 (-1000~1000)
RI& AN

11.9. 1> - R#

BTA > - FESLUTOERECEHLUTNET,

A) FAEOHIEHT 1> (BODY)
AAEDAE - AREOHIEICEI DT« — B\ IT5 12 TY,
AE - AREZER(CEBRSETVWCEEICHERLET,

B) A4EES > (BODY ANGLE)
KEDIEE (BE) (CWHITDT1—RN\wIF5A12TY,
AAEMENWZR CEREI LWL D (CTDEHIC, To — RN IZITVET,

C) A ARE (BODY ANGURUER SPD)
KEMES EEDEE (BEE) (CHFDT4—RI\WwI5A1>TY,
KEBEEDT A 2 (CLDRIREIMNZDBENHDFT.

D) R+ —)LO#HES > (WHEEL)
RA—)LDEEAE - AREOFIHCEAID T — R\ IOT51>TY,
AE - AREZRECIERSETVWE S CTFERALET.

E) RA—ILAES <> (WHEEL ANGLE)
RA—I)LDEER (BF) (CHFTDTr—R/\ywI54>TY,
A —=)LN'EIER Ul T EE LIR WK DICTDIehD T — RN I ZITVE T,
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F)

G)

H)

I

J)
K)

L)

N1 —ILAERES > (WHEEL ANGURUER SPD)
IRA—=ILAEER S SROEE (ARE) (ST - \wIT51>TT,
IRA —ILBEDT A 2 (CLDFERENADBENHDET.

R —)L#BES > (WHEEL CORRELATION)
EADIRA —)LEDREZWIET DIZHD T« — R\ IOTF1>TT,
AE - AREZECIERSETVWESICTHERAULET.

R —)LAEEAES 1> (WHEEL CORRELATION ANGLE)
EAEDRA —ILDEER (AE) ORECHITDII«—RI\WIF541>TT,

EBEDRA —)LDEED/ NSNS TEERMEDEFIL TUEDSDT,. TNZMWRBEHIC T — RN

W I&EITVET,

R —)LAEEAAEERES > (WHEEL CORRELATIO NANGURUER SPD)
ERORA =)L EEE T SEDRE (ARE) ORECHIDIT1—RI\wIT5+A4>TT,
A —)VIERREDS 1 2 (CLDFRIRZINZ DBE N DD FT,

AHIELEHI S 1> (CURRENT P)

HHliEE345 > (CURRENT I)

DC E—YDERFIHD T« — R)\w OG54 > T,

POA 2 (FERIEDEDRE. 151U (HMREDEDMECHTDI T+ — R\ I54A4>2TT,

i

Sy 1O0t>Y HPF %% (GYRO HPF)

S0t Yn T MDD (LT ORISR HPF ZREXSNTED. TDHY hAD

[EiRE e RE I DICHDFRENTT

(Aspd(t) + Apsd(t— 1) x 0.5)
dt

Angle(t) = Gypp X Angle(t— 1) +

O~ 1DETEETE, EZTIFDENY MATREKREN RO, & 1(CFDEDY bATRERK

N 0Hz (HPF A OFF) (C72D&FE T,
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M) AF>3FH)L51> (OPTION 1~6)
AERDYT A >%& FlashROM (CIRFTEET,
CSETHMTOIS LZERE. TOTOISLATHERAT DT> - F=/\5>9-27005
N5 FlashROM (CRFF T D ENBIRET T

% Microsoft, Visual Studio (&. *[E Microsoft Corporation DRERUVZDMDE(CH IF D EFEIZE/Z(E
BECY,

¥ Windows MIER&FRE. Microsoft Windows Operating System T9,

XKEDM, BESNTLDIEHER. Hmild. FHOEREBREICE/ECT.

WA 7 aryn—" BEBmNBAIRZES

; 5
10&00.: !M!Jl!

b

X %X - Amazon * YahooD&WeblE#f. F3¥ER. BEOEORY VY —EHTH
Oy FEEBRZEBEVWKOWELEITET,

ARy b EYY—RERERE (RRIXRE) | ARy bEYY—-AKRRII7E (ERXHE)

T101-0021 T814-0001
ERSTFREXRS#ET-9-9 WHEEIL4F ERATERXEEE2-3-2 TNCHGESEE2F
ORAZI7PA

RmlCRATHHHMULaHE

REEDERMEZHEHREE, ER - CERDRRLGEZRHD L, XA—ILIKTERVWELET,
E-mail : infodesk@vstone.co.jp

(BBLRCZVFEAN BBETORMIVESHBIIZII T TED Tt A,

Robot d=aXy—av¥Ah! Ofy RCMT3YYTLE—vavnyIvO—K, BEEEQOIVTIYLEN I

LET'S%ROBOT http://lets-robot.com

Ustone, 1 Ah> #atai www.vstone.co.jp

® T555-0012 KERFFARMER IXEES 2-15-28
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